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Preface 

This user guide: 

 Provides information about arrays, disks, and RAID levels (RAID types). 
 Describes how to improve storage system performance or reliability by understanding array 

and disk tasks and options. 
 Describes how to acquire and load RAIDXpert2 drivers for Windows® and Linux® operating 

systems. 
 Describes the features and procedures for using RAIDXpert2, which is the RAIDXpert2 GUI. 

Intended Audience 
This user guide is intended for use by system administrators and technicians who are experienced 
with the following: 

 Direct Attached Storage (DAS), Storage Area Network (SAN), or Network Attached Storage 
(NAS) operators 

 Network administration 
 Network installation 
 Storage system installation and configuration 

Prerequisites 
Prerequisites for installing and configuring this product include familiarity with: 

 Servers and computer networks 
 RAID and input/output signal technology (such as SCSI, or SATA) 
 Fibre Channel and Ethernet protocols 
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Document Conventions and Symbols 
Table 1. Document Convention 

Convention Element 
Navy blue, underlined text 
(http.//www.example.com) 

Web site addresses 

Bold font Key names 
Text typed into a GUI element, such as into a box 
GUI elements that are clicked or selected, such as menu and list 
items, buttons, and check boxes 

Italics font Text emphasis 
Monospace font File and directory names 

System output 
Code 
Text typed at the command line 

Monospace, Italic font Code variables 
Command line variables 

Monospace, bold font Emphasis of file and directory names, system output, code, and 
text typed at the command line 

Customer Support 
For customer support, contact your system supplier or motherboard vendor. 

Glossary 
Table 2. Glossary of Terms 

Term Definition 
rcadm A command line interface (CLI) tool for managing RAID controllers on 

Linux®, on Windows®, and UEFI operating systems. It is used for 
creating, transforming, and deleting arrays; and adding and removing 
disks. 

Legacy disk Legacy disks include new or unrecognized disks which may contain data 
or even an operating system. Legacy disks appear in the BIOS 
Configuration Utility and in RAIDXpert2 as legacy arrays. When the 
legacy disk is initializing, configuration data is written to the disk. The 
legacy array then becomes an online disk usable in arrays. 
CAUTION: A legacy disk can contain valid data. When a legacy disk is 

initialized, all data on the disk is lost. 
Linux® Free, open-source UNIX-based operating system. 
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Chapter 1 Safety Precautions 

1.1 General 
This section includes general safety precautions and specific RAIDXpert2 cautions. Read and 
keep this user manual for future reference. 

1.2 Safety Definitions 
CAUTION: Indicates that failure to follow directions could result in damage to equipment or 

data. 

IMPORTANT: Provides clarifying information or specific instructions. 

Note: Provides additional information. 

TIP: Provides helpful hints and shortcuts. 

1.3 Caution Messages 
This section lists the Caution messages that appear in the book. 

1.3.1 Caution Messages About Disks 

CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an 
automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the 
disk for the fail-over to complete, or assign a different disk with enough space. If a 
dedicated spare is assigned and a disk fails, the restore process starts automatically, 
if there is enough space available on the dedicated spare. 

CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization. 
To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted 
during initialization so ensure the correct disks are chosen to initialize. 

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, or when its 
corresponding legacy disk is initialized, the data is lost. 

CAUTION: When a disk is initialized, all data on the disk is lost. 

1.3.2 Caution Messages About Arrays 

CAUTION: Deleting an array permanently destroys all data that is on the array. This action 
cannot be undone and it is very unlikely the data can be recovered. 
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CAUTION: Do not delete the first array listed in the Arrays section, if it is the AMD-RAID 
bootable array. Doing this deletes the operating system and AMD-RAID files. 

CAUTION: Do not initialize a disk that is part of an array. Initializing a disk in a non-redundant 
array deletes the array and its data. The array no longer appears in Array View. This 
is especially true for a non-redundant bootable array. Initializing a disk in a non-
redundant bootable array causes the array to Fail and deletes the operating system, 
RAIDXpert2 files, and device drivers. 

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being 
corrupted if the system experiences a power interruption or unexpected shutdown. 

CAUTION: Prior to removing an array, remove its drive letter (Windows) or unmount the array 
(Linux). 

CAUTION: All data contained in a RAIDXpert2 array are lost if the RAIDXpert2 disks of the 
array are migrated to a non-RAIDXpert2 system. 

CAUTION: When an array is securely erased, the data on the array is lost. 

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to 
function properly, but are not supported. 

CAUTION: Creating a redundant array with Skip Initialization selected can result in data 
corruption. 

CAUTION: Hot-Swapping is not recommend for disks that are part of the Boot Virtual Disk or 
which are connected to the AMD 300- Series Chip. 
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Chapter 2 Getting Started 

2.1 RAIDXpert2 Technology 
RAIDXpert2 consists of (a) storage management and (b) a RAID controller and port virtualization. 
RAIDXpert2 runs on existing systems by using a motherboard’s built-in SATA ports. 

2.2 Who Should Use This Manual 
Only trained, experienced, and authorized personnel should install RAIDXpert2 and use its 
features and capabilities.  

All unit operators must be familiar with system hardware, data storage, RAID technology, 
input/output signal technology (such as SCSI, SAS, or SATA), and Direct Attached Storage 
(DAS), Network Attached Storage (NAS), and/or Storage Area Network (SAN) concepts and 
technology.  

The intended user audience of this user manual is system administrators and experienced users. 

2.3 System Requirements for Using RAIDXpert2 
Make sure the systems that use RAIDXpert2 meet the requirements indicated in Table 3. 

Table 3. System Requirements for RAIDXpert2 
Component Requirements 

Memory (RAM) Minimum: 4 GB. 
Recommended: 8 GB. 

Hard disk 1–12 SATA or SSD drives. The number of disks depends on the number, 
type, and capacity of the arrays to be created. In some circumstances, more 
than 12 disks are possible. They may appear to function properly, but are 
not supported by AMD-RAID 

2.3.1 Supported Controllers 

The following controllers are supported by the current release of RAIDXpert2: 

 AMD Socket AM4-Compatible Processors 
 AMD 300-Series Chipsets 
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2.3.2 Supported Operating Systems 
RAIDXpert2 currently supports the following operating systems: 

 Microsoft® Windows® 7: Professional Edition, Ultimate Edition; 32  bit and 64 bit 
 Microsoft Windows 10: 64 bit 
 Red Hat Enterprise Linux® (RHEL) 7.2 64 bit 
 Ubuntu Desktop Linux 15.04 32 bit and 64 bit 
 Ubuntu Desktop Linux 15.10 32 bit and 64 bit  

2.4 Features of RAIDXpert2 
The features of RAIDXpert2 described in this user manual apply to all license levels and 
supported operating systems.  

Table 4 describes these features. Also see Table 5, on page 20, for a summary of features that are 
available with each license level of RAIDXpert2: RAIDXpert2 Basic and RAIDXpert2 Plus. 

Table 4. Features of RAIDXpert2 
RAIDXpert2 Feature Description 

Arrays (general information) RAIDXpert2 allows: 
 Creating arrays of different RAID levels using the same disks. 
 Creating different RAID level arrays on the same disk, to adapt each 

array to the I/O that it processes.  
 Creating an array from a mix of different type disks. For example, a 

RAID10 array can be created from a group of disks that contain two 
SATA II HDDs and two SATA SSDs.  

 The ability to create RAID10 or RAIDABLE arrays may not be 
available on your system. 

 Migrating an existing array to another RAID level, if the type of array 
being used is not the optimal type for the application. This function 
depends on the array capacity, redundancy level and RAIDXpert2 
license level.  

 An array refers to data storage created by RAIDXpert2 from one or 
more disks. Although an array can be created from several disks, it is 
seen by the operating system as a single disk. 

Array Hiding An array can be hidden from the operating system so that neither the 
software nor users can see or access it. 
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Table 4. Features of RAIDXpert2 (Continued) 
RAIDXpert2 Feature Description 

Array Recovery If an array is accidentally deleted, it might be recovered by creating a 
new array with the same properties as the deleted array. (This can occur 
only if disk Write Access operations are not in-progress.) 

Background Array 
Initialization (BGI) 

The background initialization of a redundant array creates the redundant 
data that allows the array to survive a disk failure.  
Background initialization allows a redundant array to be used 
immediately. Data is not lost if a disk goes offline prior to completion of 
the BGI process. 

Cache Support for Arrays Various array-caching options are supported: No Cache, Disk Read 
Ahead Cache, Write Back Cache, Read + Write Back Cache. 

Cache Support for Disks Various disk-caching options are supported: No Cache, Disk Read Ahead 
Cache, Disk Write Back Cache, Disk Read Ahead + Write Back Cache. 

Secure Erase All data on an array can be erased and ensured it is unrecoverable, even 
with advanced data recovery techniques. 

Consistency Check A Consistency Check is a background operation that verifies and corrects 
the mirror or parity data for fault-tolerant disks. It is recommended that a 
Consistency Check be run periodically on an array. 

Disk Roaming With disk roaming, SATA cables can be disconnected from their disks 
and shuffled without confusing RAIDXpert2. 
Note: Disconnect the SATA cables from the disks only when the system is 

shutdown.  
Disk roaming also allows:  
 Disks to be moved to different slots in the backplane. RAIDXpert2 

detects which disks belong to which arrays, regardless of where the 
disks are moved in the backplane.  

 Disk(s) to be moved between systems.  
Note: It might not be possible to move disks between systems if they 

contain boot arrays. 
Fault Tolerance The following fault tolerance features are available with RAIDXpert2, in 

order to prevent data loss in case of a failed disk. 
 Disk failure detection (automatic). 
 Array rebuild using hot spares (automatic, if the hot spare is 

configured for this functionality). 
 Parity generation and checking (RAID5 only). 
 Hot-swap manual replacement of a disk without rebooting the system 

(available only for systems with a backplane that supports hot-
swapping) is not recommend for disks that are part of the Boot 
Virtual Disk or are connected to the AMD 300-Series Chipset. 

For example if a disk fails in RAID1, the array remains functional and 
data is read from the surviving mirrored disk. 

Mirror Rebuilding A broken mirrored array can be rebuilt after a new disk is inserted and the 
disk is designated as a spare. The system does not have to be rebooted. 
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Table 4. Features of RAIDXpert2 (Continued) 
RAIDXpert2 Feature Description 

Multiple RAID Levels per 
Disk 

Support for multiple array levels per disk allows the administrator to 
create arrays of different RAID levels using the same disks. 

Native Command Queuing 
(NCQ) 

Native Command Queuing is a command protocol of disks that are 
supported by RAIDXpert2. NCQ enables individual disks to internally 
optimize the order in which Read and Write commands are executed. 
RAIDXpert2 permits a queue depth of up to 32 read/write commands per 
disk. 

Online Capacity Expansion 
(OCE) 

OCE is a process that allows the user to add storage capacity to an 
existing array, without taking the system offline. OCE enables the user to 
increase the total storage capacity of an array by integrating unused 
storage into the array. 
Data can be accessed while the disks are added and while data on the 
array is being redistributed.  
Note: This feature is not available with all license levels. See Table 5. 

Online RAID Level Migration 
(ORLM) 

With online RAID level migration, users can easily move an array from 
one RAID level to another. While the migration is taking place, data is 
accessible and protected to the lowest protection of either the source 
RAID level or the destination RAID level. 
Note: This feature is not available with all license levels. See Table 5. 

RAID Level Support RAIDXpert2 supports RAID levels 0, 1, 5, 10, Volume, and RAIDABLE. 
Note: RAID5, and RAIDABLE are not supported by all license levels. See 

Table 5. 
Note: The ability to create RAID10 or RAIDABLE arrays may not be 

available on your system. 
Self-Monitoring Analysis and 
Reporting Technology 
(SMART) 

SMART is a hard-disk-drive (HDD) capability which allows reporting of 
reliability information. If a drive anticipates there is a high likelihood of 
future failure it triggers a SMART error condition. RAIDXpert2 presents 
this error condition so the drive can be replaced before the predicted 
failure occurs. 
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2.5 RAIDXpert2 Feature Set 
IMPORTANT: The supported feature set (for RAIDXpert2 Basic or RAIDXpert2 Plus) is 

determined by the license level that is included in the system BIOS. Refer to the 
system’s motherboard specifications for the supported features. 

Table 5. Feature Set for RAIDXpert2: by RAIDXpert2 License Level 

 License Levels 

Features Sub-Features RAIDXpert2 
Basic 

RAIDXpert2 
Plus 

Option ROM (BIOS) 
Support1 

Create array Yes Yes 

Delete array Yes Yes 

Boot/INT13 control Yes Yes 

RAID Levels 
Supported2 

0 Yes Yes 

1 Yes Yes 

5 No Yes 

10 Yes Yes 

RAIDABLE Yes Yes 

Volume Yes Yes 
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Table 5. Feature Set for RAIDXpert2: by RAIDXpert2 License Level (Continued) 

 License Levels 

Features Sub-Features RAIDXpert2 
Basic 

RAIDXpert2 
Plus 

Array Creation 

No initialization Yes Yes 

Foreground 
initialization Yes Yes 

Background 
initialization Yes Yes 

Array Deletion  Yes Yes 

Array Transformation  Yes Yes 

Sparing 
Global Yes Yes 

Dedicated Yes Yes 

Consistency Check 
Background Yes Yes 

Scheduled Yes Yes 

Online Capacity Expansion (OCE)3  No Yes 

Online RAID Level Migration (ORLM)  No Yes 

Drive/Disk Roaming4 

Same-system support Yes Yes 

Between-systems 
support Yes Yes 

RAIDXpert2 Web GUI (Management 
GUI)  Yes Yes 

rcadm (management CLUI)  Yes Yes 

Drive Interfaces Supported5 

SATA Yes Yes 

SSD Yes Yes 

ATAPI Yes Yes 
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Table 5. Feature Set for RAIDXpert2: by RAIDXpert2 License Level (Continued) 

 License Levels 

Features Sub-Features RAIDXpert2 
Basic 

RAIDXpert2 
Plus 

Dissimilar Disk Support Within The Same 
Array  Yes Yes 

Cache Support 

No Cache Yes Yes 

Read Cache Yes Yes 

Write Back Cache Yes Yes 

Read with Write Back 
Cache Yes Yes 

Create Array and Delete Array Functions 
Without Rebooting  Yes Yes 

Restore (Rebuild) Priority  Yes Yes 

Multiple RAID Levels per Disk6  Yes Yes 

Touched Region Logging7  Yes Yes 

E-mail Event Notification  Yes Yes 

System Event Log Integration  Yes Yes 

Instant Create Support8  Yes Yes 

Hot-Swap Support9  Yes Yes 
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Notes:  

1. At the AMD BIOS Configuration Utility (also referred to as the Option-ROM) arrays can be created or 
deleted, and Critical or Offline arrays are indicated. INT13 support can be turned off completely at the 
BIOS Configuration Utility. 

2. See Chapter 3, Arrays, Disks and RAID Levels, on page 24, for detailed information about 
understanding arrays, RAID levels, and performance and reliability considerations. 

3. The unique ability of RAIDXpert2 to provide online expansion to RAID levels across multiple disks 
becomes extremely valuable when expanded storage is a requirement. 

4. Disk roaming allows arrays to be moved from port to port, either within the same system or between 
systems. 

5. See the system’s motherboard specifications for the supported device interface. 
6. Multiple RAID levels (array types) per disk allows the administrator to create different RAID levels on 

the same disks. For example: The administrator wants data redundancy for the user data, and creates a 
RAID5 set using part of the disks’ data. At the same time the administrator wants performance for the 
swap spaces, and creates a RAID0 array using the rest of the disks’ capacities (space). This feature is 
useful in collecting unused capacity from disks with different capacities. 

7. This feature increases data integrity for redundant array types, by logging areas of an array that have 
been written to. In the event of a system crash, the logged area’s consistency is checked and/or 
corrected. Without this feature, data corruption might occur. 

8. Arrays can be instantly created and used by skipping the background consistency check. For certain 
types of redundant arrays this is a viable option and has no data integrity drawbacks. A consistency 
check can always be done at a later time. If an initialization is skipped when using RAID5, the array is 
not redundant until a consistency check is performed. 

9. Disks can be added to the system and to an array while the system is operating, but is not recommend 
for disks that are part of the Boot Virtual Disk or which are connected to the AMD 300-Series Chipset. 
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Chapter 3 Arrays, Disks and RAID Levels 

3.1 Understanding Arrays 
Arrays are several disks that are grouped together to improve either the performance or reliability 
of a storage system. Because some RAID levels enhance performance while others improve 
reliability, it is important to consider the user’s needs when planning an array configuration. 

Note: It is highly recommended that this user manual be reviewed in its entirety before 
configuring arrays. Some of the advanced features of RAIDXpert2 (such as sparing options) 
must be understood by the user before creating arrays. 

3.2 RAID Levels 
RAIDXpert2 supports the RAID levels indicated in Table 6. 

Table 6. RAID Levels – General Characteristics 

RAID Level Main Characteristic Use/Usefulness 

RAID0 (Striping)  Provides the highest performance 
but no data redundancy. Data in 
the array is striped (distributed) 
across several disks. 

 Supports 2-8 disks. 

RAID0 arrays are useful for holding 
information, such as the operating 
system paging file, where performance 
is extremely important but redundancy 
is not. 

RAID1 
(Mirroring) 

 Mirrors data on a partition of one 
disk to another. 

 Supports 2 disks. 

Useful when there are only two disks 
available and data integrity is more 
important than storage capacity. 
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Table 6. RAID Levels – General Characteristics (Continued) 

RAID Level Main Characteristic Use/Usefulness 

RAID10 (Striped 
RAID1 Sets) 

 Combines mirrors and stripe sets. 
RAID10 allows multiple disk 
failures, up to 1 failure in each 
mirror that has been striped. 

 Supports 4, 6, or 8 disks. 

Offers better performance than a 
simple mirror because of the extra 
disks.  
Requires twice the disk space of 
RAID1 to offer redundancy. 

Volume (JBOD)  RAIDXpert2 treats one or more 
disks or the unused space on a 
disk as a single array.  

 Supports 1 to 8 disks 

Provides the ability to link-together 
storage from one or several disks, 
regardless of the size of the space on 
those disks. 
Useful in scavenging space on disks 
unused by other disks in the array. 
Does not provide performance benefits 
or data redundancy. Disk failure will 
result in data loss. 

RAIDABLE (also 
known as RAID 
Ready) 

 Allows a RAIDABLE disk to be 
transformed later to RAID0 or 
RAID1. 

 Supports one disk. 

See RAID0 (Striping), on page 24 or 
RAID1 (Mirroring) on page 24 for 
post-transformation usefulness. 

3.3 Array States 
Within the management applications, an array is a logical device that can exist in one of four 
states: Normal, Ready, Critical, or Offline.  

 In RAIDXpert2, these states display in the Array List section in a column named State.  
 Within the rcadm Command Line tool, these states also display in a column named State.  
The array states are defined in Table 7, on page 26. 
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Table 7. Array States 

State Description 

Normal The Normal state is displayed when everything is functioning correctly. 

Ready The Ready state is displayed while an array is being created. 

Critical The Critical state is displayed when the array is no longer redundant (fault 
tolerant) because of one or more disk failures. Arrays can still be read and written 
to, but the data is no longer protected should another disk fail. 

Offline The Offline state is displayed when arrays cannot be read or written to because of 
one or more disk failures. 

 
Whether an array is marked as Critical or Offline depends upon what RAID level it is and how 
many disks within the array have failed. Note the changes in state in Table 8. 

Table 8. Failure States by RAID Level 

RAID Level This Failure State Is Displayed Whenever 

RAID1  
(Redundant Arrays) 

Critical A single disk fails. 

Offline Two or more disks fail. 

RAID10 
(RAID Levels with Multiple 
Redundancies) 

Critical A single disk fails in any one of the 
sets. 

Offline All disks in a set fail. 

Volume and RAID0 Offline A single disk fails. 

 
More than one array can be created using the same set of disks. If a disk is disconnected that 
belongs to more than one array, only the arrays that try to access the disk and receive I/O errors 
report the failure. For example: there are two arrays, both of which are RAID5 sets, and both use 
disk 4. If a system that is being used by array 1 receives an I/O error when trying to communicate 
with disk 4, the state of array 1 changes to Critical. However, the state of array 2 using disk 4 does 
not change to Critical until an I/O error is reported. If systems using array 1 are not 
communicating with failed disk 4, the state of array 1 still displays as Normal.  

If a rescan of all channels is performed after disconnecting a disk, the state of every array using 
the missing disk changes from Normal to either the Critical or Offline, depending on the RAID 
level. 
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See Section 3.9, Rescanning Disks for Changes in State, on page 30 for a discussion of when to 
rescan disks and the outcomes when doing so. 

3.4 Creating Arrays: Future Expansion 
When creating arrays, consider whether disk capacity needs to expand in the future. If the file 
system must be expanded, perform the tasks indicated in Table 8. 

Table 9. Array Expansion Considerations 

Operating System Do This... And Consider This... 

Microsoft® Windows® Format the arrays with 
NTFS. Microsoft 
Corporation provides a 
utility (Diskpart.exe) that can 
dynamically extend an NTFS 
file system onto any unused 
adjacent space.  
Note also that using a single 
partition per array makes 
expansion much easier. 

1. The Diskpart.exe utility version 
depends on which version of the 
Windows operating system is 
running. 
2. The Diskpart.exe utility can be 
found on the CD for some versions 
of Windows operating systems, or on 
the Microsoft Corporation website 
(http://www.microsoft.com) 
for other versions. Use the correct 
version for the operating system. 

Linux® Use an expandable file 
system. 

Because RAIDXpert2 software is 
limited to eight arrays, if a large 
number of logical volumes are 
needed, use a logical volume 
manager (LVM). 

3.5 Expanding Disk Capacity Online: Using OCE 
(Supported by RAIDXpert2 Plus) 

Online Capacity Expansion (OCE) allows: 

 Adding disks to an array at any time to increase an array’s capacity.  
 Accessing the array data while it is being redistributed.  
To increase the size and organization of an array, transform the array. For more information about 
transforming arrays, see Section 6.6.3, Transform Arrays (Supported by RAIDXpert2 Plus), on 
page 73. 

http://www.microsoft.com/
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3.6 Migrating RAID Levels Online: Using ORLM 
(Supported by RAIDXpert2 Plus) 

Online RAID Level Migration (ORLM) allows an array to move from one RAID level to almost 
any other RAID level. This task includes migrating the array from a non-redundant RAID level to 
a redundant RAID level.  

Prior to starting a RAID level migration/transformation, make sure that the disks selected for the 
destination array have sufficient capacity. RAID level migration/transformation can occur only 
when the destination array has the same or larger capacity as the source array. 

While the migration/transformation is taking place, data is accessible and protected to the lowest 
protection of either the source RAID level or the destination RAID level. 

The Transform task can also be used to expand the capacity of an array, by using OCE. It can also 
be used as part of the system backup and recovery strategy through the use of the RAID1 and 
RAID10 levels. 

To perform this process, see Section 6.6.3, Transform Arrays (Supported by RAIDXpert2 Plus), 
on page 73. 

3.7 Array Tasks: Starting and Stopping Tasks 
Tasks are started when one of the following actions are performed: 

 Create a redundant array. 
 Transform an array. 
 Restore an array. 
 Securely erase an array. 
 Check for consistency on redundant arrays. 
 Verify that data was not corrupted after a system crash (Check_Bitmap performed 

automatically). 
Full task control can be used on Create, Consistency Check and Bitmap Check tasks. On a 
Transform or Restore task for dedicated and global spares, task control can only pause/resume, but 
it cannot remove the task. To remove these types of tasks, pause and then remove them. 

The tasks indicated in Table 10 on page 29, can be displayed for each array. 
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Table 10. Types of Tasks per Array 

Task When Displayed 

Transform While an array is being transformed. 

Create While an array is being created. 

Consistency Check  While verifying that the parity (RAID5) or mirror disk (RAID1 or RAID10) 
consistency is correct. (For redundant type arrays only.)  

Restore While an array is being restored. 

Secure Erase While an array secure erase is being performed. 

Check_Bitmap While verifying that the parity on a RAID5 set, or the mirror halves on a 
RAID1 or RAID10 set, are consistent. This action is performed automatically 
to ensure that data is not corrupted whenever a system crashes. 

Not_Active When no other tasks are being performed. 

3.8 Understanding Disks 
3.8.1 Disks States 

Within the management applications, a disk can be part of one or more arrays and can exist in one 
of five states: Online, Offline, New, Legacy, or SMART Error. 

 In RAIDXpert2, these states are displayed in the Disk List section in a column named State. 
See Table 17, on page 64, for additional information. 

 Within the rcadm program, these states are also displayed in a column named State. See Table 
41, on page 102, and Table 42, on page 103, for additional information. 

The disk states are defined in Table 11. 
Table 11. Disk States 

Disk State When Displayed 

Online Whenever the disk is connected, functioning correctly, and RAIDXpert2 can 
communicate with it. 

 



  

AMD-RAIDXpert2 User Guide 53987 Rev. 3.01 June 2016  
 

30 Arrays, Disks and RAID Levels  Chapter 3 
 

Table 11. Disk States (Continued) 

Disk State When Displayed 

New Whenever an uninitialized, new disk is connected. 

Legacy Whenever a disk containing non-RAIDXpert2 configuration data is connected. 

Offline Whenever the disk fails and RAIDXpert2 detects an error condition on the disk. 

SMART Error Whenever the disk reports a SMART error(s) to RAIDXpert2. 

A disk can be a member of multiple arrays. A disk failure in one array doesn't necessarily mean it 
has failed in other arrays.  

After a rescan is performed the following can occur: 

 A disconnected disk no longer appears in the Disk List (although the disk appears as Missing 
in the Array View for the arrays to which it belonged).  

 A disk that experiences a catastrophic failure appears in the Disk List as Offline and is 
highlighted in red. The disk appears as Failed for the arrays to which it belonged. 

 A disk that has a SMART error appears in the Disk List as SMART Error. (A disk with a 
SMART error can’t be used to create an array) 

 A disk that experiences a software-related failure appears in the Disk List as Online and is 
highlighted in red. New arrays can be created with the disk.  

Arrays that exist on a failed or disconnected disk might not be designated as Failed or Missing 
until the system attempts to communicate with the failed or disconnected disk.  

3.9 Rescanning Disks for Changes in State 
The information displayed in the Disk List section is the state of the disks when they were last 
scanned. If a rescan has not been performed, the information being displayed is the state of the 
disks at boot time. 

Every time a disk is connected or disconnected while online, a message asks if the user wants to 
perform a rescan (of all SATA channels). If Rescan is selected, the information in both the Array 
List and the Disk List is updated. This view might show arrays as being in a Critical or Offline 
state, if all disks have not been installed or removed. 

Although it is highly recommended that the system be shut down before adding or removing disks, 
disks can be added or removed while the system is online (“hot-swapping”), if the system supports 
the hot-swapping function. This is not recommend for disks that are part of the Boot Virtual Disk 
or those that are connected to the AMD 300-Series Chipset. 
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Because of this function, RAIDXpert2 does not automatically perform a rescan when it detects 
that a disk has been added or removed. For example, to hot-swap a RAID5 set with six disks into a 
new system, do not perform a rescan until all six disks have been connected. 

Arrays associated with the disks that are not yet connected change state to either Critical or 
Offline. In the example above, if the state of the RAID5 set changes to Offline, data is unavailable.  

Rescanning can also result in the state of a disk being reported differently in the Array View and 
the Disk List. A disk within an array can have a state of Failed in the Array View field, while at 
the same time it can show a state of Online in the Disk List. 

3.10 Sparing Options: Disks and Arrays 
RAIDXpert2 supports multiple sparing options. Spares are restored in the order indicated in Table 
12. 

Table 12. Sparing Options 

Option Description 

Dedicated A spare disk assigned to a specific redundant array. 

Global A spare disk that is shared by multiple arrays. 

 
Note: An array is marked Critical or Offline if a disk reports a Failed state to an I/O, or if the 

SATA cable or power cable is disconnected. 

Note: One or more spares can be assigned to a redundant RAID level. 

Note: Spare assignments do not apply to non-redundant RAID levels. To protect data, transform 
the array to a redundant RAID level. Spares can then be assigned. (Be aware that the 
Transform task is supported only by RAIDXpert2 Plus.) 

3.11 Dedicated Sparing 
A dedicated spare is a disk that is assigned as an alternate disk for a specific array. Should a disk 
fail in that array, the alternate disk is used to replace the failed disk and the array is rebuilt.  

A dedicated spare can be assigned to any redundant array type, and up to four spares can be 
assigned to an array. 

CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an 
automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the 
disk for the fail-over to complete, or assign a different disk with enough space. If a 
dedicated spare is assigned and a disk fails, the restore process starts automatically, 
if there is enough space available on the dedicated spare. 
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For additional information, see Section 6.6.13, Add or Remove Dedicated Spares, on page 82.  

3.12 Global Sparing 
A global spare is a disk that is assigned as an alternate disk for multiple arrays, instead of 
associating it with only one array.  

Many arrays can be restored using the global spare disk, as long as it is not already part of the 
array and it has enough space available. Unlike a dedicated spare, this type of spare can be 
assigned at any time, even while tasks are running on arrays. 

Assigning a disk for use as a global spare does not reserve space on that disk. An automatic restore 
is not guaranteed if a disk fails.  

If there is not enough disk space on the global spare, make room for the fail-over to complete, or 
assign a different disk with enough capacity as the spare. If there is enough space available on the 
global spare and a disk failure occurs, the restore process starts automatically. 

For additional information, see Section 6.6.14, Add or Remove Global Spares, on page 83.  

3.13 RAID Performance Considerations 
With RAID technology, performance is based on the following considerations:  

 The number and organization of disks in an array. 
 Caching attributes used for the array. 
 Application workload. 

3.13.1 Number and Organization of Disks 

RAID functions increase performance by putting more disks to work and by buffering data for the 
host.  

Many disks can transfer data at greater than 100 MB per second. RAIDXpert2 can aggregate this 
bandwidth in an almost linear fashion, as more of the same disks are included in an array. 

3.13.2 Caching Attributes 

Arrays can also be configured to provide read and Write Back caching using RAIDXpert2, if 
desired. Write Back caching has a large effect on most workloads, but should be used with 
caution. 
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3.13.3 Application Workload 

When configuring an array, workload is probably the most important performance variable. Most 
applications do many more reads than writes. The best performance is obtained with array types 
like RAID0, RAID5, or RAID10. 

3.14 RAID Reliability Considerations 
RAID reliability is enhanced through data redundancy and backup.  

3.14.1 Data Redundancy 

RAID1, RAID5, or RAID10 are necessary for redundancy. With redundancy, both capacity and 
performance are sacrificed for reliability. With RAIDXpert2, extremely high performance is 
obtained even with redundant-type arrays. 

3.14.2 Backup 

It is good practice to back up your data periodically in case of a catastrophic failure. Tape backup 
or other media can be used to secure your data. 

3.15 Flexibility and Expansion Considerations 
Before configuring an array, consider the following points to enhance the flexibility of the RAID 
system. 

3.16 Multiple RAID Levels 
With RAIDXpert2, different RAID levels can be created on the same disk, to adapt each array to 
the I/O that it processes. Also, more than one array can be created per disk. 

Depending on the array capacity and redundancy level, an existing array can be transformed to 
another RAID level, if the level of the array being used is not the optimal RAID level for the 
application. Also, different arrays with different characteristics can be built for different 
applications. 

3.17 RAIDABLE Arrays 
RAIDABLE arrays (also known as RAID Ready) are a special type of Volume (JBOD) that allow 
the user to add more storage space or create a redundant array after a system is installed. 
RAIDABLE arrays are created using Option ROM, UEFI, or rcadm. 

Note: The ability to create RAIDABLE arrays may not be available on your system. 
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Chapter 4 BIOS Configuration Utility 

4.1 When to Use the AMD-RAID Controller BIOS 
Configuration Utility 

The AMD-RAID Controller BIOS Configuration Utility is also known as the Option ROM. Use 
the utility to accomplish the procedures indicated in Table 13. 

Table 13. When to use the AMD-RAID Controller BIOS Configuration Utility (Option 
ROM) 

Procedure Description Find Information At 

Initialize a new disk To initialize a new disk drive for data 
storage. 

Section 4.4, Initialize Disks, 
on page 35 

Create or delete arrays Create arrays at different RAID levels 
(depending on the license level for the 
system), or delete an array. 

Section 4.5, Create Arrays, on 
page 36 
Section 4.6, Delete Arrays, on 
page 38 

Swap arrays Change the array order, especially for the 
AMD-RAID bootable array. 

Section 4.7, Swap Arrays, on 
page 38 

Manage hot spares Allows selection of global and dedicated 
hot spares. 

Section 4.8, Manage Spares, 
on page 39 

View disk and array 
details 

View information about each disk or array.  Section 4.9, View Disk 
Details, on page 40 
Section 4.10, View Array 
Details, on page 40 

Rescan all channels Rescan all channels to detect new or 
removed disks and arrays. 

Section 4.11, Rescan All 
Channels,  on page 41 

Change controller 
options 

Change INT13 boot support, turn off 
Critical arrays or warning for Offline 
arrays while booting, or change the 
number of disks that can be spun-up when 
the system is powered-on. 

Section 4.12, Change the 
Controller Options, on page 41 

Continue to boot Exit the BIOS Configuration Utility and 
continue booting the system. 

Section 4.13, Continue 
Booting from the BIOS 
Configuration Utility, on page 
42 
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4.2 Access the AMD-RAID Controller BIOS 
Configuration Utility 

When booting the system, press Ctrl + R when the BIOS banner displays. There is a maximum of 
three seconds to use this key combination to enter the BIOS Configuration Utility. 

Note: If the BIOS Configuration Utility does not display, contact your system or motherboard 
supplier. 

4.3 Understanding the Color Code in the BIOS 
Configuration Utility 

Color codes indicate the type or status of information at the BIOS Configuration Utility. See Table 
14. 

Table 14. BIOS Configuration Utility Color Codes 

Color Description 

White text Indicates an available option or informational text. 

Black text, yellow 
highlighting 

Indicates an option or device for which action might be taken. 

Yellow text Indicates information about the yellow-highlighted option. 

Green text Indicates an item that has been selected. 

Light blue text Indicates that the item cannot be selected. 

Magenta text Indicates items that are related to spares. 

Red text Indicates a failed virtual or physical disk or a warning. For example, 
informational text might be red if an option is not available. 

4.4 Initialize Disks 
New disks and legacy disks must be initialized before they can be used to create an AMD-RAID 
array.  

Initialization writes AMD-RAID configuration information (metadata) to a disk. 
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4.4.1 Initialize Disks  

CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization. 
To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted 
during initialization so ensure the correct disks are chosen to initialize. 

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, all data on the 
disk is lost. 

1. At the Main Menu, use the arrow keys to highlight Initialize Disk(s). 
2. Press Enter to select Initialize Disk(s). 
3. Select the disks to initialize: 
 To select all disks, press the A key 
 To select individual disks, highlight a disk with the arrow keys and press Insert. Any number 

of disks may be selected using this method 
4. Press Enter to initialize the selected disks or press ESC to cancel the initialization. 
Initialization takes 10 to 15 seconds per disk. During initialization, a status indicator shows which 
disk is being initialized. When the initialization is complete, the status indicator turns off. A 
complete rescan of all channels is done automatically during initialization. 

4.5 Create Arrays  
Arrays can be created after the disks are initialized. See Section 3.2, RAID Levels, on page 17, for 
deciding what type of RAID levels to use for the array.  

TIP: See also Section 6.6.1, Create and Format Arrays  on page 71, and Section 9.4, Create New 
Arrays: rcadm --create, on page 104. 

4.5.1 Before You Begin 

 In some circumstances, more than eight arrays are possible. They might appear to function 
properly, but are not supported by AMD-RAID. 

 For redundant arrays, the Create process starts after the operating system and AMD-RAID OS 
drivers have been installed and the system has booted to the operating system. However, the 
arrays are immediately available to use for either a bootable array or a data array. 

 Array numbers are valid only for a given boot, and might be different in the BIOS 
Configuration Utility and RAIDXpert2. If a permanent label is required, use the Array Naming 
feature. 

 At any point in the procedure, return to a prior window by pressing ESC. 
 If the system is booted from an AMD-RAID bootable array, the first array in the Arrays 

section must be the bootable array. The system boots only from the first array in the Arrays 
section. As necessary, use the Swap Two Arrays feature to swap arrays and place the 
RAIDXpert2 bootable array in the first position. 
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4.5.2 Create an Array 

Note: The ability to create RAID10 arrays may not be available on your system. 

1. At the Main Menu, use the arrow keys to highlight Create Array.  
2. Press Enter. 
3. Select the disks with which to create the array: 
 To select all disks, press the A key 
 To select individual disks, highlight a disk with the arrow keys and press Insert. Any number 

of disks may be selected using this method 
4. Press Enter to include the selected disks in the array. 
5. In the User Input section, use the arrow keys to select an array type. Only array types that 

can be created with the selected disks are available. 
6. Press Enter. 
7. Select an array size by doing the following: 

a. To create an array whose size is less than or equal to 2.199 TB: 
 Press the Page Up or the up arrow key to increase the array size and the Page Down 

or down arrow key to decrease the size. 
 Press Enter when the desired size is reached. 

b. To create an array whose size is greater than 2.199 TB: 
 Press the Page Up or the up arrow key to increase the array size. 
 Press Enter when the desired size of 2.199 TB is reached.  

Note: A message displays stating that a size greater than the maximum is being 
attempted, and whether the size of the array should be limited.  

 Press ESC to bypass the Page Up or the up arrow key to continue modifying the size.  
 Press Enter when either the desired size or the maximum available size is reached. 

8. Select a caching level using the arrow keys then press Enter. 
9. Press the C key to confirm the array settings or press ESC to go back to a previous page. 
10. Repeat step 8 through step 11 to create additional arrays. 
Note: When installing the operating system to an AMD-RAID bootable array, modify the boot 

priority list in the motherboard BIOS. See the motherboard’s user documentation for more 
information. Ensure that the AMD-RAID bootable array is included in the boot priority list.  

11. Ensure that INT13 support is enabled on the RAID controller, as described in Section 4.12, 
Change the Controller Options, on page 41. 

4.5.2.1 Create an AMD-RAID Bootable Array 

CAUTION: Do not use eSATA drives for bootable arrays as they are removable. 
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The operating system and RAIDXpert2 files can be installed to a RAIDXpert2 bootable array. Use 
the procedure in Section 4.5.2, Create an Array, on page 37, to create the bootable array. Ensure it 
is the first array listed in the Arrays section of the BIOS Configuration Utility. 

To install the operating system and RAIDXpert2 files see Chapter 5, Software Installation, on 
page 43. 

4.5.2.2 Create a RAIDABLE Array 

Note: The ability to create RAIDABLE (also known as RAID Ready) arrays may not be available 
on your system. 

1. At the Main Menu, use the arrow keys to highlight Create Array, then press Enter. 
2. Select the disk with which to create the array, then press Enter to include the selected disk in 

the array: 
3. In the User Input section, use the arrow keys to select RAIDABLE, then press Enter. 
4. Press the C key to confirm array settings, or press the ESC key to go back to a previous page. 

4.6 Delete Arrays  
CAUTION: Deleting an array permanently destroys all data that is on the array. This action 

cannot be undone and it is very unlikely the data can be recovered. 

CAUTION: Do not delete the first array listed in the Arrays section, if it is the AMD-RAID 
bootable array. Doing this deletes the operating system and AMD-RAID files. 

4.6.1 Delete an Array 

1. At the Main Menu, use the arrow keys to highlight Delete Arrays then press Enter.  
2. Select the arrays to delete: 

 To select all arrays, press the A key. 
 To select individual arrays, highlight an array with the arrow keys and press Insert. Any 

number of arrays may be selected using this method. 
3. Press Enter to delete the selected arrays. A warning message displays. 
4. Press the C key to confirm the deletion, or press the ESC key to exit to the Main Menu. 

4.7 Swap Arrays 
Use the Swap Two Arrays option to arrange arrays in a different order. 

4.7.1 Before You Begin 

 If more than one array is created, install the operating system to any of them. However, a small 
amount of boot information is always written to a disk(s) in the first array (Array 1) of the 
Array section, regardless on which array the operating system is installed.  
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 It is recommended that the user install the operating system on an AMD-RAID bootable array 
at a redundant RAID level—such as RAID1 or RAID5—and swap the array into the first 
position, if it is not already Array 1. 

 Swapping arrays can be performed only at the BIOS Configuration Utility. 

4.7.2 Swap Arrays 

1. At the Main Menu, use the arrow keys to highlight Swap Two Arrays, then press Enter..  
2. Select the arrays to swap: 

a. Highlight an array using the arrow keys. 
b. Press Insert to select it. 
c. Highlight a different array using the arrow keys. 
d. Press Insert to select it. 

3. Press Enter to swap the arrays. 

4.8 Manage Spares 
This option allows the user to assign or unassign global or dedicated spares. 

4.8.1 Assign Global Spares 

1. At the Main Menu, use the arrow keys to highlight Manage Host Spare(s), then press 
Enter. 

2. Use the arrow keys to highlight Assign Global Hot Spare(s), then press Enter. 
3. Select the disks to assign as global spares: 
 To select all disks, press the A key 
 To select individual disks, highlight a disk with the arrow keys and press Insert. Any number 

of disks may be selected using this method 
4. Press Enter to assign the selected disks as global spares. 

4.8.2 Assign Dedicated Spares 

1. At the Main Menu, use the arrow keys to highlight Manage Host Spare(s), then press 
Enter. 

2. Use the arrow keys to highlight Assign Dedicated Hot Spare(s), then press Enter. 
3. Use the arrow keys to highlight the array. (must be a redundant array) 
4. Press Insert to select the array, then press Enter. 
5. Select the disks to assign as dedicated spares. 
 To select all disks, press the A key. 
 To select individual disks, use the arrow keys to highlight the disk and press Insert to select 

it. Any number of disks may be selected using this method. 
6. Press Enter. 
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7. Press the C key to continue, or press the ESC key to return to the Main Menu. 

4.8.3 Unassign Spares 

1. At the Main Menu, use the arrow keys to highlight Manage Host Spare(s), then press 
Enter. 

2. Use the arrow keys to highlight Unassign Hot Spare(s), then press Enter. 
3. Select the disks to unassign as spares: 
 To select all disks, press the A key. 
 To select individual disks, use the arrow keys to highlight the disk and press Insert to select 

it. Any number of disks may be selected using this method. 
4. Press Enter to unassign the selected disks. 
5. Press the C key to continue, or press the ESC key to return to the Main Menu. 

4.9 View Disk Details 
This option allows the user to view details about the disk. Nothing can be changed using this menu 
option; it is for informational purposes only.  

1. At the Main Menu, use the arrow keys to highlight View Disk Details, then press Enter. 
2. Use the arrow keys to highlight a disk. Information about the disk is displayed in the 

Information field across the top: 
 Unique Disk ID 
 Drive Type 
 Cache Settings 
 Maximum Free Space 
 Model Number 
 Serial Number  

3. Press ESC to exit to the Main Menu. 

4.10 View Array Details 
This option allows the details of the array to be viewed. Nothing can be changed using this menu 
option; it is for informational purposes only.  

1. At the Main Menu, use the arrow keys to highlight View Array Details, then press Enter. 
2. Use the arrow keys to choose an array. 
3. The full details of the array are displayed in the Information field across the top: 
 Array number 
 RAID level 
 Size 
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 State 
 Cache settings 

Note: The disks in the array are selected (green). 

4.11 Rescan All Channels 
This option allows the user to rescan all channels to detect new or removed disks and arrays. It 
rereads the configuration information from each disk. 

Sometimes when a disk is offline, it can be brought online through a rescan. 

1. At the Main Menu, use the arrow keys to highlight Rescan All Channels.  
2. Press Enter. 
3. The activity indicator in the Information field spins while the disks are being polled. 

4.12 Change the Controller Options 
Controller Options allows the user to configure options for the boot sequence. 

Note: By default, all options are On. It is recommended that options remain On. 

4.12.1 Booting the System from an Array 

This option allows the user to enable boot support. 

It is recommended that this option be disabled only if the system is booted from another device. 

1. At the Main Menu, use the arrow keys to highlight Controller Options then press Enter.  
2. Use the arrow keys to highlight Toggle INT13 Boot Support. 
3. Press Enter to toggle between On and Off. 
4. Press ESC to return to the Main Menu. 

4.12.2 Pausing the Boot Sequence for Warning Messages 

When the Pause feature is enabled and an array goes critical, offline, or there is another problem 
with the system, the boot process stops and an error message is displayed on the screen. The user 
must press Enter to continue booting.  

If the Pause feature is disabled, error messages are briefly displayed as the system continues to 
boot. 

1. At the Main Menu, use the arrow keys to highlight Controller Options, then press Enter.  
2. Set pauses to the boot sequence for critical warnings.  

a. Use the arrow keys to highlight Toggle Pause if Critical. 
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b. Press Enter to toggle between On (enables pauses) and Off (disables pauses). 
3. Set pauses to the boot sequence for offline warnings by doing the following:  

a. Use the arrow keys to highlight Toggle Pause if Critical. 
b. Press Enter to toggle between On (enables pauses) and Off (disables pauses). 

4. Press ESC to return to the Main Menu. 

4.12.3 Change the Staggered Spinup Count 

Depending on a system’s power supply load-rating, the end-user might want to limit the number 
of disks that are spun-up together when a system is powered on.  

For example, if a system has six disks and the staggered spinup count is set to 2, RAIDXpert2 
sends a command to spin-up disks 1 and 2 together, then disks 3 and 4, and finally disks 5 and 6. 

1. At the Main Menu, use the arrow keys to highlight Controller Options, then press Enter. 
2. Use the arrow keys to highlight Set Staggered Spinup Count, then press Enter. The 

number within the brackets changes color to indicate it is selected. 
3. Use the arrow keys to change the number within the brackets. The minimum is 1 and the 

maximum is 8.  
4. Press Enter to save the setting, or press ESC to return to the Main Menu. 

4.13 Continue Booting from the BIOS Configuration 
Utility 

After settings have been changed, continue booting the system from the point where the user 
entered the RAIDXpert2 BIOS Configuration Utility.  

4.13.1 Resume the Boot Process 

1. At the Main Menu, use the arrow keys to highlight Continue to Boot.  
2. Press Enter. 
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Chapter 5 Software Installation 

This Installation Guide is designed to assist you with system setup, by performing these general 
procedures: 

5.1 System Setup Process Overview 
A generic system setup process follows these steps: 

1. Copy the AMD-RAID drivers to a removable storage medium. 
CAUTION: Install the device drivers and applications on a system at the same time that the 

Windows or Linux operating system is installed. 

2. Power on the system. 
3. Access the platform BIOS setup for the system. For supported AMD chipsets, set the SATA 

mode as RAID. (This enables the loading of the AMD-RAID Option-ROM). 
4. Initialize the disks using the AMD-RAID Array Configuration Utility. 
5. Create arrays using the AMD-RAID Array Configuration Utility. 
6. Install the AMD-RAID drivers on the system. 
7. Load the operating system. 
8. Install the OS RAID Management Suite (AMD RAIDXpert2) on the system. 
Note: To protect your data, always perform a backup prior to installing any new, major hardware 

or software. 

5.2 Before You Begin 
Have the Windows® or Linux® operating system software available and ready to install. 

5.3 Copying AMD-RAID Drivers to Removable Storage 
You need to copy the drivers to a removable storage medium before you begin the installation. 

5.3.1 Copying AMD-RAID Drivers in a Microsoft® Windows® 
Environment 

1. Power on the system. 
2. Locate and use a system that is running a Windows operating system and has a CD DVD 

drive or an I/O port for removable storage media (such as a USB flash drive). 
3. Go to a browser and access the web site of your system supplier or motherboard vendor. 
4. Insert the storage medium into the system: 



  

AMD-RAIDXpert2 User Guide 53987 Rev. 3.01 June 2016  
 

44 Software Installation  Chapter 5 
 

 Connect a USB flash drive to a USB I/O port or insert a blank CD-DVD disk into the 
applicable drive. 

5. Download the AMD-RAID drivers from the web site to the appropriate removable storage 
medium. 

5.3.2 Copying AMD-RAID Drivers in a Linux® Environment 

1. Power on the system. 
2. Locate and use a system that is running a Windows operating system and has a USB I/O port 

for the USB flash drive. 
3. Use a browser to access the web site of your system supplier or motherboard vendor. 
4. Insert a USB flash drive into the USB I/O port of the system. 
5. Download the AMD-RAID drivers for the correct distribution version of Linux®. Copy the 

drivers onto the USB flash drive:  
 For Red Hat Linux: Copy the .iso image file (that matches the applicable distribution of Linux 

to the USB flash drive . For example:  
 dd-rcraid-RHEL7-3.10.0-327.el7-x86_64.iso 

 For Ubuntu: Copy the files contained inside the dd-rcraid-Ubuntu [Ubuntu version 
number].w.x-yz-folder into a dd directory located on a USB flash drive. For an Ubuntu 
desktop server installation the following files should be located in the dd directory located on 
the USB flash drive root. For example: 

 dd 
 load_amdraid 
 post_install 
 post_install2 
 pre_install 
 rcraid.ko 
 rcraid_generic.ko 
 readme 

5.4 Pre-installation steps 
You can choose to boot from the platform BIOS (Basic Input-Output System) or from UEFI. 
UEFI is a recent industry to standardize boot procedures that, until recently, have been platform-
specific. 

5.4.1 BIOS Mode 

1. Power on the system and press ESC.. 
2. Select SCU , and press Enter 
3. In the BIOS setup: 
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a. Select the AMD-CBS tab. 
b. Select AMD FCH Common Options, then press Enter. 
c. Select SATA Configuration Options, then press Enter. 
d. Set SATA Mode to RAID, then press Enter. 

4. In the BIOS setup: 
a. Select the AMD-CBS tab. 
b. Select Promontory Common Options, then press Enter. 
c. Select PT SATA Configuration Options, then press Enter. 
d. Set PT SATA Mode to RAID, then press Enter. 

5. In the BIOS setup: 
a. Select the Boot tab. 
b. Set Boot type to Legacy or Dual Boot Type, then press Enter. 
c. Set EFI Device First to Disabled, then press Enter.  

6. Verify that the AMD-RAID bootable array is included in the system's boot priority list. 
7. At the system's Power-On Self-Test (POST) screen, press Ctrl + R to access the AMD-

RAID Array Configuration Utility (also called Option-ROM). 
8. Scroll to Controller Options and verify that INT13 Boot Support is ON for AMD-RAID. 
9. If more than one array exists at the AMD-RAID Array Configuration Utility, verify that the 

desired bootable array is the first array listed in the Arrays list. Use the Swap Two Arrays task 
to place the bootable array first. 

5.4.2 UEFI Mode 

1. Power-on the system then press ESC. 
2. Select SCU, and press Enter. 
3. In the BIOS setup: 

a. Select the AMD-CBS tab. 
b. Select AMD FCH Common Options, then press Enter. 
c. Select SATA Configuration Options, then press Enter. 
d. Set SATA Mode to RAID, then press Enter. 

4. In the BIOS setup: 
a. Select the AMD-CBS tab. 
b. Select Promontory Common Options, then press Enter. 
c. Select PT SATA Configuration Options, then press Enter. 
d. Set PT SATA Mode to RAID, then press Enter. 

5. In the BIOS setup: 
a. Select the Boot tab. 
b. Set Boot Type to Dual or UEFI Boot Type, then press Enter. 
c. Set EFI Device First to Enabled, then press Enter. 



  

AMD-RAIDXpert2 User Guide 53987 Rev. 3.01 June 2016  
 

46 Software Installation  Chapter 5 
 

6. At the system's Power-On Self-Test (POST) screen, press F7 / F12 / ESC (or similar) to 
access the UEFI Configuration Utility (also called UEFI Boot Manager). 

7. Boot to the EFI Internal shell 
8. Enter fsx:, where x is the number of the UEFI Flash Drive. 
9. Use rcadm to create the desired Boot Virtual Disk. Refer to Appendix A, rcadm.efi 

Information, on page 107 for more information.  

5.5 Installing AMD-RAID drivers 
Follow the procedures below for your Microsoft Windows or Linux installation. 

5.5.1 Installing AMD-RAID Drivers while Installing Microsoft® Windows® 

5.5.1.1 Installing AMD-RAID BIOS Drivers during a Microsoft® Windows® 7 or 
Windows® 10 Installation 

Note: The windows described in this procedure are typical. Path names and text can vary, 
depending on user-designated selections and other parameters. 

1. Power on the system. 
Note: Do not boot up with a USB flash key in the system when performing an install, as the system 

will use that as the boot device. 

2. Create a bootable array by following the procedure in Section 4.5.2.1, Create an AMD-RAID 
Bootable Array, on page 37.  

3. Insert the Microsoft Windows operating system CD-ROM or DVD into the system’s CD or 
DVD drive. 

4. Boot the system and let it access the Microsoft Windows operating system CD-ROM or 
DVD. 

5. At the Windows setup dialog box, do the following: 
a. Select the language, time, and keyboard options, then click Next. 
b. Click Install Now. If prompted, select the desired operating system, then click Next. 
c. Insert the storage medium with the AMD-RAID drivers into the USB port or applicable 

system drive, then click Browse. 
d. Navigate to the directory containing the saved AMD-RAID drivers, then click OK. 
e. Select the first rcbottom.inf driver in the list, then click Next. 

Note: If the installation has multiple controllers, there will be two, or more, rcbottom.inf’s listed. 

6. At the Load Driver window do the following: 
a. Click OK, Browse. 
b. Navigate to the directory containing the saved AMD-RAID drivers, then click OK. 
c. Select the first rcraid.inf driver in the list, then click Next. 
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d. Select the I Accept the License Terms checkbox, then click Next. 
e. Select Custom: Install Windows Only (advanced) option. 
f. Click Load Drivers, Browse. 
g. Navigate to the directory containing the saved AMD-RAID drivers, then click OK. 
h. Select the rccfg.inf driver, then click Next. A valid drive displays at the Windows 

installation location screen. 
i. Click Next, then follow the on-screen instructions to complete the installation. 

7. Once the OS installation is complete, open Device Manager and verify the following: 
 In the Expand Storage Controllers list, the AMD-RAID Bottom Device and AMD-

RAID Controller entries are displayed. 
 In the Expand System Devices list, the AMD-RAID Config Device entries are 

displayed. 
8. Remove the storage medium and Microsoft Windows operating system CD-ROM or DVD 

from the applicable drive(s) or port. 
9. Proceed to Section 5.6, Installing the AMD RAIDXpert2 Management Suite for Microsoft® 

Windows®, on page 57. 

5.5.1.2 Installing the AMD-RAID UEFI Drivers during a Microsoft® Windows® 7 or 
Windows® 10 Installation 

Note: The windows described in this procedure are typical. Path names and text can vary, 
depending on user-designated selections and other parameters. 

1. Power on the system. 
Note: Do not boot up with a USB flash key in the system when performing an install, as the system 

will use that as the boot device. 

2. Create a bootable array by following the procedures in Section 4.5.2.1, Create an AMD-
RAID Bootable Array, on page 37. 

3. Insert the Microsoft Windows operating system CD-ROM or DVD into the system's CD or 
DVD drive. 

4. Boot the system and allow it to access the Microsoft Windows operating system CD-ROM or 
DVD. 

5. At the Windows setup dialog box, do the following: 
a. Select the language, time, and keyboard options, then click Next. 
b. Click Install Now. If prompted, select the desired Operating System, then click Next. 
c. Insert the storage medium with the AMD-RAID drivers into the USB port or applicable 

system drive, then click Browse. 
d. Navigate to the directory containing the saved AMD-RAID drivers, then click OK.  
e. Select the first rcbottom.inf driver in the list, then click Next.. 

Note: If the system has multiple controllers, there will be two or more rcbottom.inf’s listed. 
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6. At the Load Driver Window, do the following: 
a. Click OK, Browse. 
b. Navigate to the directory containing the saved AMD-RAID drivers, then click OK. 
c. Select the first rcraid.inf driver in the list, then click Next. 
d. Select the I Accept the License Terms checkbox, then click Next. 
e. Select Custom: Install Windows Only (advanced) option. 
f. Click Load Drivers, Browse. 
g.  Navigate to the directory containing the saved AMD-RAID drivers, then click OK. 
h. Select the rccfg.inf driver, then click Next. A valid drive displays at the Windows 

installation location screen. 
7. Click Next, then follow the on-screen instructions to complete the installation. 
8. Once the OS installation is complete, open Device Manager and verify the following: 

 In the Expand Storage Controllers list, the AMD-RAID Bottom Device andAMD-RAID 
Controller entries are displayed. 

 In the Expand System Devices list, the AMD-RAID Config Device entries are displayed. 
9. Remove the storage medium and Microsoft Windows OS CD-ROM or DVD from the 

applicable drive(s) or port. 
10. Proceed to Section 5.6, Installing the AMD RAIDXpert2 Management Suite for Microsoft® 

Windows®, on page 57. 

5.5.2 Installing AMD-RAID Drivers While Installing Linux® Operating 
System 

Note: The Linux® operating system modules must include the gcc+ compiler and the pthreads 
library so that the rcadm program can be installed properly. 

5.5.2.1 Installing the AMD-RAID BIOS Drivers During a Red Hat Enterprise Linux® 
7.2 64 bit (RHEL) Installation 

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or 
motherboard vendor. Copy the AMD-RAID drivers to a USB flash drive, following the 
instructions in Section 5.3.2, Copying AMD-RAID Drivers in a Linux® Environment, on 
page 44 . 

Note: When installing Red Hat Linux, use the Linux dd installation mode instead of the Linux 
expert mode.  

Note: Not all of the windows indicated in this procedure will appear during the installation. 

1. Power on the system. 
2. Insert the USB drive that contains the AMD-RAID drivers into the USB port. 
3. Insert the Red Hat operating system CD-ROM or DVD into the system’s CD or DVD drive. 
4. Create a bootable array by following the procedure in Section 4.5, Create Arrays, on page 36. 
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5. At the Red Hat Enterprise Linux welcome window, do the following: 
a. Press the Up arrow, then select Install Red Hat Enterprise Linux 7.2. 
b. Press Tab. 
c. Type modprobe.blacklist=ahci inst.dd nomodeset at the end of the existing string then 

press Enter. For example, vmlinux initrd.img……..quiet modprobe.blacklist=ahci 
inst.dd nomodeset 

6. At the Driver Disk Device Selection, press 1 (the number of the flash drive), then press 
Enter. 

7. At the Choose Driver Disk ISO file, press 1 (the number of the dd-rcraid-
RHEL….el7.2x86_64.iso entry), then press Enter. 

8. At Select Drivers to Install, do the following:  
a. Press 1 (the number of the /media/DD/…..x86_64.rpm entry), then press Enter. The 

/media/DD/… is selected and should look like [X] /media/DD/……x86_64.rpm.  
b. Press the C key, then press Enter. 

9. At the Driver Disk Device Selection, press the C key, then press Enter. 
10. At the Welcome to Red Hat Enterprise Linux Screen, do the following: 

a. Choose the desired Language and Country. 
b. In the bottom right corner, then click Continue. 

11. At the Installation Summary Screen: 
a. Under Localization, configure the following:  

 Date and Time  
 Keyboard  
 Language Support  

b. Under Software, configure the following:  
 Installation Source  
 Software Selection  

 Under Base Environments, select Server with GUI.  

 Under Add-Ons for Selected Environments, select Compatibility Library.  

 In the upper left corner, click Done.  
c. Under System, configure the following:  

 Installation Destination  
 Under Local Standard Disks, select AMD-RAID Array.  

 In the upper left corner, click Done.  

 Network and Hostname  
 In the bottom left corner, enter a valid Hostname.  

 Select an Ethernet Port.  
 In the bottom right corner, click Configure.  
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 Enter valid entries.  
 Click Save.  

 In the upper left corner, click Done.  
12. In the bottom right corner, click Begin Installation. 
13. At the Configuration window, do the following: 

a. Click Root Password: 
 Enter an applicable root password. 
 Re-enter the root password. 
 In the upper right corner, click Done. 

b. Click User Creation: 
 Enter a Full Name. 
 Enter a Username. 
 Enter an applicable password. 
 Re-enter the user password. 
 In the upper right corner, click Done. 

14. When the Installation Complete message displays, do the following: 
a. In the bottom right corner, click Reboot. 
b. Eject and remove the USB flash drive and the installation media. 

15. At the Initial Setup of Red Hat Enterprise Linux Server 7.2, do the following: 
a. Press 1, then press Enter. 
b. Press 2, then press Enter. 
c. Press R, then press Enter. 
d. Press the C key, then press Enter. 

16. Login to the system and do the following: 
a. Select a user. 
b. Enter a password. 

17. At the Welcome window, select the desired language, then click Next 
18. At the Select Input Sources Window, select the desired Input Source, then click Next. 
19. If desired, Configure Online Accounts, then click Next. 
20. Click Start using Red Hat Enterprise Linux Server. 
21. For RHEL 7.2 64 bit installs, manually load the following el7.686 rpms. 

a. Allow the system to boot and login as root when prompted. 
b. Insert the RHEL 7.2 x 64 installation CD/DVD into the system. 
c. Install the following rpms: 

 libX11…el7.i686 
 libXau…el7.i686 
 libxcb…el7.i686 
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 libXext…el7.i686 
 libXi…el7.i686 
 libXtst…el7.i686 
 gtk2……el7.i686 
 libstdc++*.el7.i686 
 libSM-*.el7.i686 
 libpng12*.el7.i686 
 adwaita-gtk2-theme-*.el7.i686 
 libcanberra-gtk2-*.el7.i686 
 PackageKit-gtk3-module-*.el7.i686 

22. Open a Web Browser, then do the following: 
a. Go to rpmfind.net 
b. Search for compat-libstdc++-33 
c. Download and install the compat-libstdc++-33-3.2.3-71.el7.i686.rpm 
d. Reboot the system. 

5.5.2.2 Installing the AMD-RAID BIOS Drivers during a Supported Ubuntu Desktop 
Installation 

Note: AMD-RAIDXpert2 supports the Ubuntu 15.04 and 15.10 desktop operating systems.  

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or 
motherboard vendor. Copy the AMD-RAID drivers to the dd directory on a USB flash drive, 
following the instructions in Section 5.3.2, Copying AMD-RAID Drivers in a Linux® 
Environment, on page 44.  

Note: The Ubuntu driver CD-ROM .iso image contains all Linux variations for a particular 
release.  

Note: Some of the windows indicated in this procedure might not appear during the installation.  

1. Power on the system.  
2. Remove the Ethernet cable from the system.  
3. Insert the Ubuntu desktop operating system CD-ROM or DVD into the system's CD or DVD 

drive.  
4. Create a bootable array by following the procedure in Section 4.5, Create Arrays, on page 36.  
5. As soon as the Ubuntu desktop kernel starts loading, press F6 to go to Advanced Options.  
6. Select the desired language, then press Enter.  
7. Press F6 - Other Options, then press ESC.  
8. Press the down arrow key to Install Ubuntu.  
9. At the end of the Boot Options string, type the following, then press Enter: break=mount 

nomodeset  
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Note: The string should look like the following: splash -- break=mount nomodeset  

10.  When the BusyBox shell displays, perform the following steps:  
a. Insert the USB flash drive.  
b. Type the following, pressing Enter after each one:  

 mount -t vfat /dev/sdal /tmp  
Note: /dev/sda1 may need to be changed to /dev/sdb1 or /dev/sdc1, depending on the number of 

devices there are.  

 cp -ap /tmp/dd /  
 /dd/pre_install  
 umount /tmp  
 exit  

c. Remove the USB flash drive.  
11. When the Welcome screen displays, select the desired language then click Continue.  
12. Accept the defaults, then click Continue.  
13. Accept the default settings, then click Continue.  
14. Select Erase Disk and install Ubuntu, then click Install Now.  
15. From the Write Changes to Disks? window, then click Continue.  
16. Select the desired time zone, then click Continue.  
17. Select the desired keyboard layout, then click Continue.  
18. Enter valid entries for the following, then click Continue.  

a. Your name  
b. Computer name  
c. User name  
d. Password  
e. Confirm Password  

19. When the Installation Complete window displays, do the following:  
a. Insert the USB flash drive.  
b. Press CTRL + ALT + F1.  
c. At the Ubuntu dialog box, enter ubuntu as the username, then press Enter.  
d. When prompted to enter a password, leave it blank, then press Enter.  
e. Type the following, pressing Enter after each one:  

 sudo mount -t vfat /dev/sdal /mnt  
 sudo cp -ap /mnt/dd /  
 sudo /dd/post_install  

20. Wait for the Setup is Complete message, then press CTRL + ALT + F7.  
21. Click Restart Now to finish the installation.  
22. When prompted, remove the CD/DVD and USB flash drive from the system, then press Enter.  
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23. Reconnect the Ethernet cable.  
24. Proceed to Section 5.7, Installing the AMD RAIDXpert2 Management Suite for Linux®, on 

page 58.  

5.5.2.3 Install the AMD-RAID UEFI Drivers during a RHEL 7.2 64 bit Linux® 
Installation 

Note: The Linux operating system modules must include the gcc+ compiler and the pthreads 
library, so that the rcadm program can be installed properly. 

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or 
motherboard vendor. Copy the AMD-RAID drivers to a USB flash drive. See Section 5.3.2, 
Copying AMD-RAID Drivers in a Linux® Environment, on page 44. 

Note: When installing Red Hat Linux, use the Linux dd installation mode instead of the Linux 
expert mode. 

Note: Not all of the windows indicated in this procedure will appear during the installation. 

1. Power on the system. 
2. Insert the USB drive containing the AMD-RAID drivers. 
3. Insert the Red Hat operating system CD-ROM or DVD into the system’s CD or DVD drive. 
4. Create a bootable array by following the procedures in Section 4.5.2.1, Create an AMD-RAID 

Bootable Array, on page 37. 
5. At the Red Hat Enterprise Linux Welcome window: 

a. Press the Up arrow. 
b. Select Install Red Hat Enterprise Linux 7.2 64 bit. 
c. Press the E key. 
d. At the end of the existing string, type modprobe.blacklist=ahci inst.dd nomodeset  

For example, the string should look like the following: linuxefi /images……..quiet 
modprobe.blacklist=ahci inst.dd nomodeset 

e. Press CTRL X. 
6. At the Driver Disk Device Selection, press 1 (the number of the flash drive), then press Enter. 
7. At the Choose Driver Disk ISO file, press 1 (the number of the dd-rcraid-

RHEL….el7.2x86_64.iso entry), then press Enter. 
8. At the Select Drivers to Install, do the following: 

a. Press 1 (the number of the /media/DD/…..x86_64.rpm entry). 
b. Press Enter. The /media/DD/… is now selected and should look like [X] 

/media/DD/……x86_64.rpm 
c. Press the C key, then press Enter. 

9. At the Driver Disk Device Selection, press the C key, then press Enter. 
10. At the Welcome to Red Hat Enterprise Linux Screen, do the following: 

a. Choose the desired language and country. 
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b. In the bottom right corner, then click Continue. 
11. At the Installation Summary Screen: 

a. Under Localization, configure the following: 
 Date and Time 
 Keyboard 
 Language Support 

b. Under Software, configure the following: 
 Installation Source 
 Software Selection 

 Under Base Environments, select Server with GUI. 
 Under Add-Ons for Selected Environments, select Compatibility Library. 
 In the upper left corner, click Done. 

c. Under System, configure the following: 
 Installation Destination 

 Under Local Standard Disks, select AMD-RAID Array. 
 In the upper left corner, click Done. 

 Network and Hostname 
 In the bottom left corner, enter a valid Hostname. 

 Select an Ethernet Port. 
 In the bottom right corner, click Configure. 
 Enter valid entries. 
 Click Save. 
 In the upper left corner, click Done. 

12. In the bottom right corner, click Begin Installation. 
13. At the Configuration window, do the following: 

a. Click Root Password: 
 Enter an applicable root password. 
 Re-enter the root password. 
 In the upper right corner, click Done. 

b.  Click User Creation: 
 Enter a Full Name. 
 Enter a Username. 
 Enter an applicable password. 
 Re-enter the user password. 
 In the upper right corner, click Done. 

14. At the Installation Complete window, click Reboot in the bottom right corner, then eject and 
remove the USB flash drive. 
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15. At the Initial Setup of Red Hat Enterprise Linux Server 7.2, do the following: 
a. Press 1, then press Enter. 
b. Press 2, then press Enter. 
c. Press R, then press Enter. 
d. Press the C key, then press Enter. 

16. Login to the system, then do the following: 
a. Select a user. 
b. Enter a password. 

17. At the Welcome window, select the desired language, then click Next. 
18. At the Select Input Sources window, select the desired input source, then click Next. 
19. If desired, Configure Online Accounts, then click Next. 
20. Click Start using Red Hat Enterprise Linux Server. 
21. For RHEL 7.2 64 bit installs, manually load the following el7.686 rpms: 

a. Allow the system to boot and login as root when prompted. 
b. Insert the RHEL 7.2 64 bit installation CD/DVD into the system. 
c. Install the following rpms: 

 libX11…el7.i686 
 libXau…el7.i686 
 libxcb…el7.i686 
 libXext…el7.i686 
 libXi…el7.i686 
 libXtst…el7.i686 
 gtk2……el7.i686 
 libstdc++*.el7.i686 
 libSM-*.el7.i686 
 libpng12*.el7.i686 
 adwaita-gtk2-theme-*.el7.i686 
 libcanberra-gtk2-*.el7.i686 
 PackageKit-gtk3-module-*.el7.i686 

22.  Open a Web Browsr and do the following: 
a. Go to rpmfind.net. 
b. Search for compat-libstdc++-33 
c. Download and install the compat-libstdc++-33-3.2.3-71.el7.i686.rpm 
d. Reboot the system. 
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5.5.2.4 Installing the AMD-RAID UEFI Drivers during a Supported Ubuntu Desktop 
Installation 

Note: AMD-RAIDXpert2 supports the Ubuntu 15.04 and 15.10 desktop operating systems. 

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or 
motherboard vendor. Copy the AMD-RAID drivers to the dd directory on a USB flash drive, 
see Section 5.3.2, Copying AMD-RAID Drivers in a Linux® Environment, on page 44. 

Note: The Ubuntu driver CD-ROM .iso image contains all Linux variations for a particular 
release. 

Note: Not all of the windows indicated in this procedure will appear during the installation. 

1. Power on the system. 
2. Remove the Ethernet cable from the system. 
3. Insert the Ubuntu desktop operating system CD-ROM or DVD into the system's CD or DVD 

drive. 
4. Create a bootable array by following the procedure in Section 4.5.2.1, Create an AMD-RAID 

Bootable Array, on page 37. 
5. Boot to the Ubuntu desktop CD-ROM or DVD. This will bring you to the GNU GRUB 

Window. 
6. Press the down arrow key to Install Ubuntu. 

Note: Press the E key to edit the commands before booting. 

7. Find the string that starts with linux /casper/vmlinuz.efi file=/cdrom…..splash -- 
8. Press the END key. 
9. At the end of the Boot Options string, type:  break=mount nomodeset 

Note: The string should look like the following: splash -- break=mount nomodeset. 

10. Press F10 to Boot. 
11. When the BusyBox shell displays, perform the following steps: 

a. Insert the USB flash drive. 
b. Type the following, pressing Enter after each one: 

 mount -t vfat /dev/sdal /tmp 
Note: /dev/sda1 may need to be changed to /dev/sdb1 or /dev/sdc1, depending on the number of 

devices. 

 cp -ap /tmp/dd / 
 /dd/pre_install 
 umount /tmp 
 exit 

c. Remove the USB flash drive. 
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12. When the Welcome screen displays, select the desired Language and then click Continue. 
13. Accept the default settings, then click Continue. 
14. Select Erase Disk and install Ubuntu, then click Continue. 
15. From the Select Drive drop-down menu, select the AMD-RAID Array, then click Install 

Now. 
16. From the Write Changes to Disks? Window, then click Continue. 
17. Select the desired Time Zone and then click Continue. 
18. Select the desired Keyboard layout and then click Continue. 
19. Enter valid entries for the following then click Continue: 

a. Your name 
b. Computer name 
c. User name 
d. Password 
e. Confirm Password 

20. When the Installation Complete window displays, do following: 
a. Insert the USB flash drive. 
b. Press CTRL + ALT + F1 
c. At the Ubuntu dialog box, enter ubuntu as the username, then press Enter. 
d. When prompted to enter a password, leave it blank, then press Enter. 
e. Type the following commands, pressing Enter after each one. 

 sudo mount –t vfat /dev/sdal /mnt 
 sudo cp –ap /mnt/dd / 
 sudo /dd/post_install 

21. Wait for the Setup is Complete message and then press CTRL + ALT + F7. 
22. Click Restart Now to finish the installation. 
23. When prompted to remove the installation media, remove the CD/DVD and USB flash drive 

from the system, then press Enter. 
24. Reconnect the Ethernet cable. 
25. Proceed to Section 5.7, Installing the AMD RAIDXpert2 Management Suite for Linux®, on 

page 58. 

5.6 Installing the AMD RAIDXpert2 Management Suite 
for Microsoft® Windows® 

Obtain the latest Catalyst executable file from your system supplier or motherboard vendor. 
Download the file to the system’s desktop and execute it. Follow the on-screen prompts. 

See Section 6.1.1.1, Browser Setup, on page 61, for supported browsers and configurations. 
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5.7 Installing the AMD RAIDXpert2 Management Suite 
for Linux® 

Obtain the AMD RAIDXpert2 Management Suite executable file (Setup.sh) from your system 
supplier or motherboard vendor. Download the Setup.sh file to the system’s desktop. 

Table 15. Linux® Procedure for Installing the Management Suite 

Element Action 

RHEL 7.2 64 bit 
Manually load the following i686 rpms - libX11, libXau, libXcb, libXext, 
libXi, libXtst, compat-libstdc++, gtk2, libSM, libpng12, adwaita-gtk2-
theme, libcanberra-gtk2 and PackageKit-gtk3-module. 

Ubuntu 15.04 and 15.10, 
32-bit operating systems 
only 

For Ubuntu 15.04 and 15.10, 32-bit operating systems, enter the following 
command before executing Setup.sh: 
sudo ln -s /lib/i386-linux-gnu/libc.so.6 

/lib/libc.so.6 

Ubuntu 15.04 and 15.10,  
64-bit operating systems 
only  

For the Ubuntu 15.04 and 15.10, 64-bit operating systems, type the 
following commands before executing Setup.sh, pressing Enter after 
each one: 
sudo ln -s /lib/x86_64-linux-gnu/libc.so.6 

/lib/libc.so.6 

sudo apt-get install lib32z1 

sudo apt-get install lib32ncurses5 

sudo apt-get install libxext6:i386 

sudo apt-get install libxtst6:i386 

sudo apt-get install libxi6:i386 

sudo apt-get install libstdc++6:i386 

sudo apt-get install libgtk2.0-0:i386 

sudo apt-get install libxxf86vml:i386 

sudo apt-get install libsm6:i386 

sudo apt-get install gtk2-engines-murrine:i386 

sudo apt-get install libcanberra-gtk-module:i386 

 

Setup.sh Verify that the Setup.sh file is executable by right-clicking on the 
Setup.sh file on the system’s desktop.  
From the pop-up menu, select the Properties category.  
Click the Permissions tab. 
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Table 15. Linux® Procedure for Installing the Management Suite (Continued) 

Element Action 

Permissions tab Ensure that the Execute or Executable checkbox(es) is/are selected.  
Click Close. 

Setup.sh icon Double-click the Setup.sh icon that is on the desktop.  
At Do you want to run ‘Setup.sh’ or display its contents?, click Run. 
Wait while Linux runs the Management Suite installer. 

Introduction window Click Next.  

License Agreement 
window 

Select I accept the terms of the License Agreement.  
Click Next.  

What would you like to 
install? window 

Click Next. 

Choose Install Folder 
window 

Accept the default settings.  
Click Next.  

Choose Shortcuts window Click Next. 

Pre-Installation Summary 
window 

Review the selections.  
If they are okay, click Install.  
Note: The Installing the AMD RAIDXpert2 Management Suite window 

appears, showing the progress of the installation. 
 

Install Complete window Click Done. 

 

5.8 Installing the AMD RAIDXpert2 Graphical User 
Interface (GUI) 

This section provides instructions for installing the AMD RAIDXpert2 GUI for Linux. For 
information on using the GUI, see Chapter 6, AMD RAIDXpert2 Graphical User Interface (GUI), 
on page 61. 

5.8.1 RHEL Linux® – AMD RAIDXpert2 Web GUI Installation   
1. Copy xampp-linux-1.8.1.tar.gz to the desktop 
2. Open a console window and navigate to /root/Desktop. 
3. Start Super User (su) mode and type the following commands, pressing Enter after each one: 
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 tar xvfz xampp-linux-1.8.1.tar.gz –C /opt 
 cd /opt/raidxpert2/htdocs 
 cp –rv raidxpert2 /opt/lampp/htdocs 

4. To start lampp, type the following, then press Enter: 
 /opt/lampp/lampp startapache 

Note: This must be done after each system reboot. 
Note: rc_cgi and lampp must be running for the Web GUI to function correctly. 

5. To start rcpopup, type the following, then press Enter: 
 /opt/raidxpert2/bin/rcpopup & 

Note: This must be done after each system reboot. 

6. Click the RAIDXpert2 Desktop Icon 
7. Enter the following default credentials: 

a. Username: admin 
b. Password: admin 

8. Create a new username and password, and log into the system again with the new credentials. 

5.8.2 Ubuntu 

1. Copy xampp-linux-1.8.1.tar.gz to the desktop. 
2. Open a console window. 
3. Navigate to /root/Desktop and type the following commands, pressing Enter after each one: 

 sudo tar xvfz xampp-linux-1.8.1.tar.gz –C /opt 
 cd /opt/raidxpert2/htdocs 
 sudo cp –rv raidxpert2 /opt/lampp/htdocs 

4. To start lampp, type the following, then press Enter: 
 sudo /opt/lampp/lampp startapache 

Note: This must be done after each system reboot. 
Note: rc_cgi and lampp must be running for the Web GUI to function correctly. 

5. To start rcpopup, type the following, then press Enter: 
 /opt/raidxpert2/bin/rcpopup & 

Note: This must be done after each system reboot 

6. Click the RAIDXpert2 Desktop Icon. 
7. Enter the following default credentials: 

a. Username:  admin 
b. Password:  admin 

8. Create a new username and password, and log into the system again with the new credentials. 



  
53987 Rev. 3.01 June 2016   AMD-RAIDXpert2 User Guide 
 

 Chapter 6 AMD RAIDXpert2 Graphical User Interface (GUI) 61 
 

Chapter 6 AMD RAIDXpert2 Graphical User 
Interface (GUI) 

6.1 Start RAIDXpert2 
RAIDXpert2 can be accessed using a web browser or Windows shortcut. 

6.1.1 Web-Browser Access 

6.1.1.1 Browser Setup 

Note: Microsoft® Edge is not supported. 

 Use Chrome version 20, Firefox version 14, Internet Explorer 8, or Safari 6, or a greater 
version of each. 

 To optimize the display, use a color monitor and set its color quality to the highest setting. 
 To navigate beyond the Sign In page (with a valid user account): 

 Set the browser’s local-intranet security option to medium or medium-low. For Internet 
Explorer 8, adding the controller’s network IP address as a trusted site can avoid access 
issues. 

 Verify that the browser is set to allow cookies at least for the IP address of the controller. 
 To see the help window in Microsoft Internet Explorer, you must enable pop-up windows. 

6.1.1.2 Signing In Using a Web Browser 

1. In the web browser’s address field, type the IP address of a controller network port and press 
Enter.  

2. The AMD RAIDXpert2 Management Tool Login is displayed. If the Login page does not 
display, verify that you have entered the correct IP address. 

3. On the Login page, enter the name and password of a configured user. The default user name 
and password are admin and admin. 

Note: Both usernames and passwords are case-sensitive. 

4. Select a language at the drop-down menu. 
5. Click Submit. If the system is available, the RAIDXpert2 GUI page is displayed; otherwise, a 

message indicates that the system is unavailable. 

6.1.1.3 Tips for Signing In and Signing Out Using a Web Browser 

 Do not include a leading zero in an IP address. For example, enter 10.1.4.33 not 10.1.4.033. 
 Multiple users can be signed in to each controller simultaneously. 
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 For each active RAIDXpert2 session an identifier is stored in the browser. Depending on how 
your browser treats this session identifier, you might be able to run multiple independent 
sessions simultaneously. Internet Explorer can run separate RAIDXpert2 sessions if you select 
File > New Session. If you do not select a new session, all instances of Internet Explorer share 
the same session. 

 End a RAIDXpert2 session by selecting Options > Logout. Do not simply close the browser 
window. 

6.1.2 Desktop Shortcut Access 

6.1.2.1 Signing In Using the RAIDXpert2 Desktop Shortcut 

1. Launch the AMD RAIDXpert2 Management Tool using by double-clicking the RAIDXpert2 
desktop shortcut..  

2. The AMD RAIDXpert2 Management Tool Login is displayed. If the Login page does not 
display, verify that you have used the correct shortcut. 

3. Select a language at the drop-down menu. 
4. On the Login page, enter the name and password of a configured user. The default user name 

and password are admin and admin. 
Note: Both usernames and passwords are case-sensitive. 

5. Click Submit. If the system is available, the RAIDXpert2 GUI page is displayed; otherwise, 
a message indicates that the system is unavailable. 

6.2 Password Protection 
When the system displays a window that prompts you to choose a username and password, use the 
procedure below. 

1. In the Username field, enter the new username. 
2. In the Password field, enter the new password. Follow the guidelines in Section 6.2.1, Things 

to Know About Passwords, on page 62. 
3. In the Confirm New Password field, re-enter the new password. 
Note: Both usernames and passwords are case-sensitive. 

4. Click Submit. 

6.2.1 Things to Know About Passwords 

 RAIDXpert2 cannot be opened without a password. Create a password that is easily 
remembered. 

 The password must be 4 - 20 characters long. 
 The password is case-sensitive. 
 The application does not track previous passwords unless enabled through your web browser. 
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 To change an existing password, see Section 6.2.2, Change a Password at the Options Menu, 
on page 63. 

 If a user forgets the username or password, delete rc_login.txt to restore the default user name 
and password (admin and admin).  

6.2.2 Change a Password at the Options Menu 

Note: Both usernames and passwords are case-sensitive. 

1. At the Options menu, select Password. 
2. The Choose a new Username and Password window displays. 
3. In the Old Password field, enter the default password you used to login. 
4. In the New Password field, enter the new password. Follow the guidelines in Section 6.2.1, 

Things to Know About Passwords, on page 62. 
5. In the New Password field, re-enter the new password. 
6. Click Submit. 

6.3 Help and About Windows® 
To view the software version and build number for the GUI, select About at the Help menu. The 
AMD RAIDXpert2 Driver Version and GUI Version displays.  

For customer support, select Help > User Guide. A pdf version of this document will display. A 
pdf reader program will be necessary to view it. 

For further customer support, contact your system supplier or motherboard vendor. 

6.4 Reviewing the RAIDXpert2 GUI 
6.4.1 The Array View Section of the Array Status Window 

6.4.1.1 Elements of the Array View Section 

The Array View section presents a graphical view of array properties. Table 16 provides 
information about the elements of the Array View section. 

Table 16. Elements of the Array View Section, Array Status Window 

Element Description 

Controller Name The RAIDXpert2 controller for the arrays displayed below it. 

Array The number assigned to an array. 

Array name The name assigned to an array. 

 



  

AMD-RAIDXpert2 User Guide 53987 Rev. 3.01 June 2016  
 

64 AMD RAIDXpert2 Graphical User Interface (GUI)  Chapter 6 
 

Table 16. Elements of the Array View Section, Array Status Window (Continued) 

Element Description 

RAID Level The RAID level of the array. 

Disk Number The number assigned to disks in an array. 

Disk Manufacturer The manufacturer of disks in an array. 

Disk Model 
Number The model number of the disks in an array. 

6.4.2 The Disk List Section of the Array Status Window 

6.4.2.1 Elements of the Disk List Section 

The Disk List section provides information about all disks assigned or available to arrays. Table 
17 provides information about the elements of the Disk List section. 

Table 17. Elements of the Disk List Section, Array Status Window 

Element Description 

Disk Disk number. 

Capacity Disk capacity:  
1 MB = 1,000,000 bytes 
1 GB = 1,000,000,000 bytes 
Note: Because the ATA storage industry has standardized the meanings of 

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 
reports the same units 

Port Type Type (SATA) and negotiated speed (not the speed of the port type). 

GS Indicates if the disk is assigned as a global spare. 

State State of the disk (Online, Offline, SMART Error). 

Type Disk type (Disk, Legacy, New). 

Model Disk manufacturer’s model number. 

Serial No. Disk manufacturer’s serial number. 
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Table 17. Elements of the Disk List Section, Array Status Window (Continued) 

Element Description 

Firmware Disk manufacturer’s firmware version. 

Space Available Total amount of space unused on the disk. 

Largest Available Largest contiguous unused space on the disk. 

Features Information about port communication and physical disk cache settings. 

If a disk is missing from the Disk List, the most likely cause is: 

 A loose cable. Make sure that all disk cables are connected, then perform a rescan. 
 A disk that is not fully seated in its bay or slot. Make sure that the disk is inserted completely 

in its bay or slot, then perform a rescan. 
For more information, see Section 6.5.2, Rescan Disks, on page 69. 

6.4.3 The Array List Section of the Array Status Window 

6.4.3.1 Elements of the Array List Section 

The Array List section provides information about the arrays. Table 18 provides information about 
the elements of the Array List section. 

Table 18. Elements of the Array List Section, Array Status Window 

Element Description 

Device The array number. 

Partition  

Drive letter that was assigned to this array during the partition process. (A 
blank space appears if the array has not been partitioned.) 
Note: If a dynamic volume is created on an array, RAIDXpert2 cannot 

retrieve the volume’s drive letter. 

Array Name User-created name for the array. 

Type The RAID level (RAID type) or LEGACY. 
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Table 18. Elements of the Array List Section, Array Status Window (Continued) 

Element Description 

Total Capacity 

Total capacity:  
1 MB = 1,000,000 bytes 
1 GB = 1,000,000,000 bytes 
Note: Because the ATA storage industry has standardized the meanings of 

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 
reports the same units. 

State State of the array (NORMAL, CRITICAL, OFFLINE). 

Task Task type, if in progress (TRANSFORM, CHECK, CHECK_BITMAP, 
CREATE, RESTORE, ZERO, SECURE_ERASE). 

Task State The state of the task (STARTED, PAUSED, COMPLETED); the progress 
of the task is given in the Array View section. 

Pri Task priority if a task is in progress. 

Scan Background Array Scan enabled? (Yes/No). 

Cache Current cache setting (NC = No Cache, R = Read Cache, WB = Write 
Back Cache, RW = Read/Write Cache). 

6.4.4 The Event View Section of the Array Status Window 

6.4.4.1 Elements of the Event View Section 

The Event View section is an optional-view section. It can be displayed or hidden by selecting 
View > Event View. 

The information in the Event View is linked to the View Log. The View Log displays user-
initiated tasks or actions, and system-generated notifications and events. The View Log can be 
accesses by selecting View > Log. 

The Event View provides information about the events. Table 19, on page 67, provides 
information about the elements of the Event View section. 
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Table 19. Elements of the Event View Section, Array Status Window 

Element Description 

# The number of the event. 

Date The date and time at which the event occurred. 

Event The RAIDXpert2 Asynchronous Event Notification (AEN) number of the event. 

Priority The notification priority of the event: Low, Informational, Warning, Critical, or Fatal. 

Text A brief description of the event. 

6.4.5 Array and Disk Commands 

The Array and Disk menus of the Array Status window contain lists of commands. The commands 
allow the system user to initiate or modify array- and disk-related tasks.  

Not all commands are available for an array or for the system. Availability depends on:  

 The tasks that can be performed with the system’s license level. 
 The RAID level of an array. For example, a Consistency Check can be performed only on 

arrays at a redundant RAID level. 
 The remaining capacity of the disk drives. For example, if a system has three disk drives and 

large arrays have used all of the capacity on two of the disks, only non-redundant Volume 
arrays can be created on the remaining disk. Certain commands are not available with a non-
redundant array. 
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Table 20 provides page numbers for each command. 

Table 20. Commands at the Array and Disk Menus 

Array Commands 
See Detailed 
Information 
on this Page 

 Disk Commands 
See Detailed 
Information 
on this Page 

Create page 71  Initialize page 68 

Name page 73  Rescan page 69 

Transform  page 73  Properties page 69 

Prepare to Remove page 77  Spare/Identify page 69 

Delete page 77    

Modify Cache Settings page 79    

Task page 80    

Check Consistency page 80    

Background Array Scan page 82    

Remove Spares page 82    

Hide page 83    

Secure Erase page 83    

6.5 Working with Disks 
6.5.1 Initialize Disks 

When a disk is initialized, RAIDXpert2 configuration information (metadata) is written to the 
disks. If a disk is new and has not been used before, or if it is a legacy disk, it must be initialized 
before it can be used in a RAIDXpert2 array. After a disk is initialized, it appears as Disk in the 
Disk List. 

Note: All new disks and legacy disks will have an associated array. You must delete the array in 
order to initialize the disk. 

6.5.1.1 To Initialize Disks 

1. At the Disk menu, select Initialize. The Initialize Disk window displays. 
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2. Select the disk(s) to be initialized, by selecting the box next to the disk(s). 
3. Click Initialize Selected. 

6.5.2 Rescan Disks 

The Rescan Command Performs the Following Actions:  

 Rescans the SATA channels that search for new, legacy, or removed disks. 
 Rereads the configuration information from each disk.  
When a disk is offline, it might be brought online by using a rescan. A rescan also stops and then 
automatically resumes all tasks. 

To rescan disks, select Rescan at the Disk menu. 

6.5.3 Change Cache Properties for Disks 

The Read Ahead and Write Back Cache properties can be changed if the disks support this option. 
The default settings are:  

 Read Ahead: enabled. 
 Write Back Cache: enabled. 
CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being 

corrupted if the system experiences a power interruption or unexpected shutdown. 

Note: A disk’s cache setting cannot be changed if a task is active for the array. The cache settings 
are enabled when the task is finished. 

6.5.3.1 Change Disk Caching Properties 

1. At the Disk menu, select Properties.  
2. The Properties window opens.  
3. Select the disks you want to change the properties of. 
4. Click Enable or Disable for the desired settings.  
Note: Each time Enable or Disable is clicked, the disk selection clears. To change multiple 

settings on one disk, select the disk before clicking each setting. 

6.5.4 Assign Spares 

Spare disks allow an array to be rebuilt when a disk fails. Global spares can be used in any array, 
while dedicated spares are assigned to a specific array. 

6.5.4.1 Assign a Disk as a Dedicated or Global Spare 

1. In the Disk List section, select a disk. 
2. At the Disk menu, select Spare/Identify.  
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3. Options for Disk Device displays in the Disk List panel.  
4. Perform one of the following actions: 
 To use the disk as a dedicated spare, select Assign as Dedicated Spare. 

Note: The capacity of a dedicated spare must be equal to or larger than the capacity of the 
smallest disk in the array. 

 To use the disk as a global spare, select Assign as Global Spare. 
5. Click Confirm. 

6.5.5 Legacy Disks 

A legacy disk is a disk that contains valid data from a non-RAID controller.  

A legacy disk appears in RAIDXpert2 (and in the BIOS Configuration Utility) with a 
corresponding legacy array. When the legacy disk is initialized in RAIDXpert2 (or in the BIOS 
Configuration Utility), the legacy array disappears. 

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted the data is lost. 

6.5.5.1 Legacy Disk and New Disk 

Table 21 provides information on how disks appear in RAIDXpert2 and in the BIOS 
Configuration Utility. 

Table 21. New and Legacy Disks, as They Appear in the BIOS Configuration Utility and 
RAIDXpert2 

Status of the Disk In RAIDXpert2 In the BIOS Configuration 
Utility 

New, un-initialized disk. The disk appears as a new disk 
with a legacy array. 
When the new disk is 
initialized, its state changes to 
Online (or similar). 

The disk appears as a new disk 
(the disk can appear with a 
legacy array). 
When the new disk is 
initialized, RAIDXpert2 
configuration data is written to 
the disk. The disk state changes 
to Empty. 
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Table 21. New and Legacy Disks, as They Appear in the BIOS Configuration Utility and 
RAIDXpert2 (Continued) 

Status of the Disk In RAIDXpert2 In the BIOS Configuration 
Utility 

A disk containing non-
RAIDXpert2 configuration 
data. 
CAUTION: A legacy disk can 
contain valid data. When a 
legacy array is deleted, or 
when its corresponding legacy 
disk is initialized, the data is 
lost. 

The disk appears as a legacy 
disk with a legacy array.  
When the legacy array is 
deleted, the legacy array 
disappears and the legacy disk 
type changes to Disk. The disk 
can now be used in 
RAIDXpert2 arrays. 

The disk appears as a legacy 
disk with a legacy array. 
When the legacy array is 
deleted the state of the legacy 
disk changes to Empty. The 
disk can now be used in 
RAIDXpert2 arrays. 

See Chapter 6, AMD RAIDXpert2 Graphical User Interface (GUI), on page 61, for the disk 
initialization procedure and the appearance of legacy disks in the BIOS Configuration Utility. 

6.6 Working with Arrays 
6.6.1 Create and Format Arrays 

RAIDXpert2 allows the partitioning and creation of as many as eight arrays across the system’s 
disks. Portions of disks can be used to create arrays, at the same time that other arrays use different 
portions of the same disks.  

6.6.1.1 Before You Begin... 

Review the issues and recommendations indicated in Table 22. 

Table 22. Creating Arrays: Issues and Recommendations 

Issues Recommendations 

Access to arrays The creation of arrays, even redundant arrays, allows users immediate 
access to the arrays (unless the Zero Create option is used during the Create 
process). 

Array numbers Array numbers are valid only for a given boot, and can be different in the 
BIOS Configuration Utility and RAIDXpert2. If a permanent label is 
required, use the Array Naming feature described in Section 6.6.2, Name 
Arrays, on page 73. 
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Table 22. Creating Arrays: Issues and Recommendations (Continued) 

Issues Recommendations 

Array size The array size of the new array is limited to 2.199 TB on some versions of 
Windows and Linux. Refer to the operating system documentation for 
details on maximum array sizes. 

Number of arrays In some circumstances, more than eight arrays are possible. They might 
appear to function properly, but are not supported by AMD-RAID. 

System reboot When the system reboots, the creation process continues where it left off. 

6.6.1.2 Create an Array 

6.6.1.2.1 Select an Array and Cache 

1. At the Array menu, select Create. 
2. Select the disk(s) to include in the array by checking the box next to the desired disk(s) in the 

Select Active Disks: field. 
Note: Click All to select all disks, or click Unused to select disks that are not currently used in an 

array. 

3. Enter a name for the array in the Array Name: field. 
Note: The following characters are not allowed in an array name 

( ) ^ , | = “  ” . 

4. Select an array type at the Array Type: drop-down menu.  
5. At the Organized As: drop-down menu select an option. 
Note: The Organized As: drop-down menu only displays options for advanced management of a 

RAID10 configuration if you selected RAID10. 

6. Enter the capacity in the Capacity: field. The maximum available capacity changes with:  
 The disks that are selected. 
 The RAID level of the array. 

7. Select a cache option at the Cache Options: drop-down menu. (The default is Read and Write 
Back Cache.) 

8. Check Background Array Scan to enable background array scanning. (A background array 
scan checks the sectors of the disks in an array for potential problems. A background array 
scan runs continuously, until the user stops it by accessing Array > Background Array Scan > 
Stop). 
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Note: See Section 6.6.12, Scan an Array in the Background, on page 82, for details. 

9. Check Skip Initialize to skip initialization. 
CAUTION: Creating a redundant array with Skip Initialization selected can result in data 

corruption. 

10. Check Leave Existing Data Intact if an array is lost or deleted, and the user immediately 
creates a replacement array of the same characteristics. This leaves the data on the disks of 
the lost or deleted array untouched when the replacement array is created. See Table 37, on 
page 92, for additional information. 

11. Check Zero Create to write zeros on the created array. If Zero Create is used, the array is not 
immediately available (the array is hidden from the operating system during the Create 
process). 

12. Click Create to create the array. 

6.6.1.3 Partition and Format an Array 

Each operating system has different names and paths for partitioning and formatting arrays and as 
such are outside the scope of this document. For more information, see your operating system’s 
user documentation. 

6.6.2 Name Arrays 

Naming an array can be useful when creating backups. It makes an array easy to identify in a list 
of arrays. 

1. In the Array View section, select the array to name. 
2. At the Array menu, select Name. The Array Name window displays. 
3. Type the desired name in the blank field.  
Note: The following characters are not allowed in an array name: 

 
( ) ^ , | = “  ” . 

4. Click OK. The array name appears in the Array List and in the BIOS Configuration Utility 
(only 17 characters of the name are displayed in the BIOS Configuration Utility). 

6.6.3 Transform Arrays (Supported by RAIDXpert2 Plus) 

With the Transform task, an array can be:  

 Transformed from one RAID level to almost any other RAID level. This function is also 
referred to as Online RAID Level Migration (ORLM).  

 Expanded dynamically, even under I/O load, by adding disks to the array to increase the 
capacity of the array. This function is also referred to as Online Capacity Expansion (OCE).  
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6.6.3.1 Before You Begin 

Review the issues and recommendations indicated in Table 23. 

Table 23. Transforming Arrays: Issues and Recommendations 

Issues Recommendations 

Array size An array cannot be transformed to a smaller-sized array. The transformed 
array must be the same size as or larger than the original array. 

Array size limits The array size of the transformed array is limited to 2.199 TB on some 
versions of the Windows and Linux operating systems. Refer to the 
operating system documentation for details on maximum array sizes. 

Disk failure during a 
Transform 

If a disk fails while the Transform task is in progress, no data is lost as long 
as the source and destination RAID levels are redundant. If a spare has been 
assigned to the destination array, a fail-over task starts as soon as the 
Transform completes (if the spare is available after the Transform). 

Multiple arrays If there are multiple arrays, it might not be possible to transform some of the 
arrays to a larger size. If, in the future, an array needs to be expanded in 
size, it is best to configure the available space as a single array. 
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Table 23. Transforming Arrays: Issues and Recommendations (Continued) 

Issues Recommendations 

Task control 
commands 

When using task control commands, a Transform task can only be paused or 
resumed but not removed. To end a Transform task, pause and delete it. 
Note: If a task is paused and then deleted, the array is deleted. Deleting a 

task is the same as deleting an array. Data loss occurs when a task is 
deleted. Please ensure that data is backed up prior to deleting a task 
involving a Transform or a Restore. 

System reboot during 
a Transform 

If the system reboots during a Transform, the Transform continues where it 
left off. 

6.6.3.2 Transform an Array 

1. In the Array View section, select the array to transform. 
2. At the Array menu, select Transform. 
Note: If the system window is not wide enough, only the Destination View is displayed. 

3. Select all the desired disks for the array (including disks that might be already in the array) 
by selecting the box next to the drive in the Disk List section. 

Note: Click Same to select all disks currently used in the array, All to select all disks, or Unused 
to select disks that are not currently used in an array. 

4. Select the RAID level to be transformed at the Array Type: drop-down menu. 
5. At the Organized As: drop-down menu select an option. 
Note: The Organized As: drop-down menu only displays options for advanced management of a 

RAID10 configuration if you selected RAID10. 

6. Expand the array by entering the size of the new array in the Capacity: field. The maximum 
available capacity changes with:  

 The disks that are selected. 
 The RAID level of the array. 

Note: If a Transform is not possible, the Commit option is not enabled. A typical reason 
preventing a Transform is insufficient available space on the disks. 

7. Click Commit. 
Note: If the system is not licensed for RAIDXpert2 Plus, a License Issue message displays when 

the user clicks Commit.  

Note: Unless the transformation is instantaneous, the Array Status window updates to show the 
source and destination arrays, along with the progress of the transformation. 
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6.6.3.3 Access Additional Space 

After an array has been transformed to a larger size, use the operating system tools to access the 
additional space.  

There are several possible methods for expanding the existing file system on an array that has been 
transformed to a larger size: 

 Microsoft® provides a command prompt utility called Diskpart.exe that can expand any NTFS 
file system without requiring a reboot. The Diskpart.exe utility version to use depends on the 
version of Windows being run. The Diskpart.exe utility can be found on the CD that comes 
with some versions of Windows, or at the Microsoft website (http://www.microsoft.com) for 
others. Use the correct version for the operating system. 

 For arrays formatted with FAT32, use a third-party application, such as PartitionMagic from 
PowerQuest Corporation. 

6.6.4 Restore (Rebuild) Arrays 

With the Restore task, a redundant-type array whose state has changed to Critical can be restored 
(rebuilt) in one of two ways: 

 By assigning a dedicated spare to the array.  
 By creating a global spare or by using an existing global spare. (An existing global spare 

automatically starts restoring a redundant-type array after the array’s state changes to Critical.) 
An array in an Offline state cannot be restored. This means that non-redundant arrays (Volume, 
RAID0) cannot be restored: when a single disk in a non-redundant array fails, the array state 
changes to Offline.  

Note: If a Critical redundant array that is being restored loses a second disk (RAID1 or RAID5), 
or loses a second disk in the same mirror set (RAID10), the Restore task fails. The array 
must be re-created from backup storage data. 

6.6.4.1 Before You Begin 

 Make sure that the disk chosen as the dedicated spare or global spare has sufficient available 
capacity to restore the array. The capacity of the spare disk must be equal to or larger than the 
capacity of the smallest disk in the critical array. 

 Know how to create a global or dedicated spare. See Section 6.6.13, Add or Remove 
Dedicated Spares, on page 82 or Section 6.6.14, Add or Remove Global Spares, on page 83. 

6.6.4.2 Restore a Critical Array 

1. In the Array View section, select the critical array. 
2. At the Disk List section, select a disk. 
3. At the Disk menu, select Spare/Identify. Options for Disk Device displays in the Disk List 

panel. Perform one of the following actions: 

http://www.microsoft.com/
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 To use the disk as a dedicated spare, select Assign as Dedicated Spare. 
 To use the disk as a global spare, select Assign as Global Spare. 

4. Click Confirm. 

6.6.5 Prepare to Physically Remove an Array 

6.6.5.1 Physically Remove an Array 

CAUTION: Prior to removing an array, remove its drive letter (Windows) or unmount the array 
(Linux). 

1. In the Array View section, select the array to remove. 
2. At the Array menu, select Prepare to Remove.  
3. At the Prepare to Remove window, click Yes. The array and all associated disks disappear 

from the Array Status window. 
4. Remove the first disk from the system.  
5. When the Drive Removed window displays, click Cancel.  
6. Remove the remaining disks in the array. 
7. When all disks in the array are removed from the system, select Rescan at the Disk menu. 

6.6.5.2 Array Migration 

The disks in an array, after being removed from one system with a RAIDXpert2 controller, can be 
migrated to another system with a RAIDXpert2 controller. The disks and array(s) appear in the 
second system, in Disk Management, the BIOS Configuration Utility, and RAIDXpert2, as normal 
RAIDXpert2 disks and array(s). 

If the disks from a RAIDXpert2 system are migrated to a non-RAIDXpert2 Windows-based 
system, the disks appear in Disk Management of the second system as healthy, unknown 
partitions. To use the disks, use Disk Management to delete the RAIDXpert2-created partitions 
and to create Windows partitions on the disks. 

CAUTION: All data contained in a RAIDXpert2 array are lost if the RAIDXpert2 disks of the 
array are migrated to a non-RAIDXpert2 system. 

6.6.6 Delete Arrays 

CAUTION: Deleting an array permanently destroys all data that is on the array. This action 
cannot be undone and it is very unlikely the data can be recovered. 

6.6.6.1 Before You Begin 

Review the issues and recommendations indicated in Table 24. 
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Table 24. Deleting Arrays: Issues and Recommendations 

Issue Recommendation 

Drive letters or 
partitions 

Remove drive letters or partitions from the array using procedures in your 
operating system. Each operating system has different names and paths for 
removing drive letters or partitions and as such are outside the scope of this 
document. For more information, see your operating system’s user 
documentation. 

Operating system 
impact on arrays 

If the array is not being used by the operating system, the array can be 
deleted at any time, even while tasks are running on the array.  
If the array is being used by the operating system, the array cannot be 
deleted. Therefore, a RAIDXpert2 bootable array cannot be deleted in 
RAIDXpert2. A RAIDXpert2 bootable array can only be deleted in the 
BIOS Configuration Utility. 

6.6.6.2 Delete an Array 

1. In the Array Status window, select the array to delete. 
2. At the Array menu, select Delete. A windows opens, warning about deleting the array. 
3. Click OK. The array disappears from the Array View section. 

Note: Also see Section 4.6, Delete Arrays, on page 38. 

6.6.6.3 Recreate a Deleted Array 

If an array is deleted, it might be possible to recreate the array. See  

Table 37, Recreate a Deleted Array, on page 92. 
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6.6.7 Change Cache Settings for Arrays 

Table 25 provides information about the four array-caching options available. 

Table 25. Cache Array Options 

Option Description 

No Cache I/O requests are translated and passed to the disks without keeping a cached 
copy of the data available for future requests 

Read Cache Data reads are cached, if appropriate. This option performs sequential Read 
Ahead, when necessary 

Write Back Cache Data writes are cached. This setting is intended for advanced users who 
understand the implications of Write Back caching 

Read + Write Back 
Cache (default setting) 

Both Read and Write Back Cache options can be selected 

 

Note: Cache options cannot be changed while a task is active on the array. They can be changed 
at any other time, including while I/O is running. 

6.6.7.1 Change Cache Settings 

1. In the Array View section, select the array on which to change caching options. 
2. At the Array menu, select Modify Cache Settings. 
3. Choose No Cache, Read Cache, Write Back Cache, or Read + Write Back Cache. The 

new cache setting displays in the Array List Cache information. 

6.6.8 Change the Priority Level of a Task 

The task priority command allows the user to speed up or slow down tasks being performed on 
arrays.  

To decrease the amount of time it takes for a task to complete, set the task priority higher (10 is 
the highest).  

Note: A task priority can only be changed after a task is running on the array.  

6.6.8.1 Change a Task Priority 

1. In the Array View section, select the array on which tasks are being performed. 
2. At the Array menu, select Task and select Priority. 
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3. At the Task Priority window, change the task priority by moving the slide one way or the 
other.  

4. Click OK. 

6.6.9 Interrupt, Cancel, or Resume a Task 

The task control commands allow the user to pause, resume, or cancel (remove) tasks being 
performed on arrays. 

Full task control can be used on Create, Consistency Check, and Check Bitmap tasks. On Restores 
with dedicated or global spares the task can be removed, but the array returns to the Critical state. 

Note: Task control can be used only when a task is running on an array. 

6.6.9.1 Interrupt, Cancel, or Resume a Task 

1. In the Array View section, select the array on which a task is being performed. 
2. At the Array menu, select Task then click: 
 Pause to interrupt the task. 
 Remove to cancel the task. 
 Resume to interrupt the task. 

6.6.10 Check for Consistency 

For redundant-type arrays only, the Consistency Check task is available at the Array menu. When 
this task is selected it starts the process of verifying that the parity (RAID5) or mirror drive 
consistency for fault-tolerant disks is correct. If inconsistent areas are found, they are corrected 
during this process. 

Having consistent arrays is very important. If an array is inconsistent and a drive fails, data is lost. 
RAIDXpert2 is designed to maintain consistent arrays, but it is good practice to run frequent 
consistency checks. See Section 6.6.11, Schedule a Consistency Check, on page 81. 

When a redundant array is created using the Create command, and the Skip Initialize option is not 
checked (the default setting), a Consistency Check is performed automatically. Although a 
Consistency Check that runs during a Create task can be removed (by highlighting the array and 
selecting Task > Remove), the array that is created is not redundant. Unless a Consistency Check 
runs from end-to-end, an array is not protected.  

After a Consistency Check has been started, adjust the priority of the Consistency Check task 
relative to user I/O activity. Use the Task Priority option (see Section 6.6.8, Change the Priority 
Level of a Task, on page 79).  

A Consistency Check task can be scheduled with the Schedule Consistency Check task (see 
Section 6.6.11, Schedule a Consistency Check, on page 81). 
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6.6.10.1 Before you Begin 

 The Consistency Check command can be started at any time on a redundant-type array, as long 
as another task is not running on the array. 

 The Consistency Check command can be started while under I/O load. 
 If the array state is Critical, the Consistency Check fails. 
 To estimate the remaining time for a Consistency Check, look at the percentage of the task that 

is completed (in hours: minutes: seconds). These details are displayed next to the array in the 
Array View section of the Array Status window. 

6.6.10.2 Manually start a Consistency Check 

1. In the Array View section, select the array on which to run the Consistency Check. 
2. At the Array menu, select Check Consistency. 
3. Click Start. 

6.6.10.3 Manually stop a Consistency Check 

1. In the Array View section, select the array on which to stop the Consistency Check. 
2. At the Array menu, select Check Consistency. 
3. Click Stop. 

6.6.11 Schedule a Consistency Check 

A Consistency Check task can be scheduled for later in the day or week. A Consistency Check 
task can be scheduled to run each week or each month. 

Note: Schedule only one Consistency Check event on an array. This means that if a monthly check 
has been scheduled and a weekly check is desired, delete the monthly event and schedule the 
new event. 

Table 26 provides information on the available scheduling options for a Consistency Check. 

Table 26. Consistency Check Options 
Option Description 

One Time Only Schedule the Consistency Check for the current day (“Today”) or up to 
seven days in the future. 

Weekly Events can be scheduled weekly. After it is selected, a Consistency Check 
runs on the specified array at the same time each week. 

Monthly Events can be scheduled to run once per month to run on the specified array 
at a specified time. 

6.6.11.1 Schedule a Consistency Check for Later  

1. In the Array View section, select the array on which to run the Consistency Check. 
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2. At the Array menu, select Check Consistency.  
3. Select Schedule. 
4. At the Check Consistency window, select the Frequency, Day, and Time, then click 

Confirm. 

6.6.11.2 Delete a Scheduled Consistency Check  

1. In the Array View section, select the array to on which to delete the Consistency Check. 
2. At the Array menu, select Check Consistency.  
3. Select Schedule.  
4. At the Consistency Check window, click Remove. 

6.6.12 Scan an Array in the Background 

A Background Array Scan task performs a continuous background read operation of an array, 
accessing at least one copy of every block of the array from beginning to end.  

A Background Array Scan is manually started by the user and runs continuously until the user 
stops it. 

Although a Background Array Scan can run while an array is engaged in other tasks, it is 
recommended that the Background Array Scan run while the array is idle (that is, when there is no 
I/O to or from the array). 

6.6.12.1 Enable or Disable a Background Array Scan 

1. In the Array View section, select the array to on which to run the Background Array Scan. 
2. At the Array menu, select Background Array Scan. 
3. Enabled or disable the Background Array Scan. 
 To enable a Background Array Scan, select Start. 
 To disable a Background Array Scan, select Stop. 

Note: A Background Array Scan can also be enabled for an array when it is created. 

6.6.13 Add or Remove Dedicated Spares 

If a dedicated spare is added, make sure there is adequate space on the dedicated spare.  

6.6.13.1 Add a Dedicated Spare 

1. In the Array View section, select the array on which to assign a dedicated spare. 
2. In the Disk List section, select the disk chosen as the dedicated spare. 
3. At the Disk menu, select Spare/Identify.  
4. Select Assign as Dedicated Spare, then click Confirm. 
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6.6.13.2 Remove a Dedicated Spare Assignment 

1. In the Array View section, select the array from which to remove a dedicated spare. 
2. At the Disk menu, select Spare/Identify.  
3. Select Remove as Dedicated Spare, then click Confirm. 
TIP: For additional information see Section 3.10, Sparing Options: Disks and Arrays, on page 31. 

6.6.14 Add or Remove Global Spares 

If a global spare is being added, make sure there is adequate space on the global spare.  

6.6.14.1 Add a Global Spare 

1. In the Disk List section, select the disk chosen as the global spare. 
2. At the Disk menu, select Spare/Identify.  
3. Select Assign as Global Spare, then click Confirm. 

6.6.14.2 Remove a Global Spare 

1. In the Disk List section, select the disk to be removed as the global spare.  
2. At the Disk menu, select Spare/Identify.  
3. Select Remove as Global Spare, then click Confirm. 

6.6.15 Hide an Array 

Hide allows the user to hide the array from the operating system. 

6.6.15.1 Hide an Array 

1. In the Array View section, select the array to hide. 
2. At the Array menu, select Hide. The array will disappear from the Array View. 
Note: If the array is currently hidden, select Array > Un-hide to display it. 

6.6.16 Secure Erase 

Secure Erase is used for erasing all data on an array and ensuring that it will be unrecoverable, 
even with advanced data recovery techniques. 

Data is Securely Erased By: 

 Hiding the array from the OS 
 Writing over each region of the disk with 3 patterns (0xAA, 0x55, and random) 
 Using a 4 pass with all zeros to ensure that a RAID1, or RAID5 will be consistent 
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After the secure erase is complete, a user can choose to manually delete the array or reuse it. If the 
user chooses to reuse it, it must be unhidden using the procedure in Section 6.6.15, Hide an Array, 
on page 83. 

CAUTION: When an array is securely erased, the data on the array is lost. 

6.6.16.1 Securely Erasing an Array 

1. In the Array View section, select the array to erase. 
2. At the Array menu, select Secure Erase, then click OK. 

6.7 Working with Views 
The View menu allows the user to:  

 Display the event view. 
 Display the event log. 
 Refresh the display. 

6.7.1 Display or Hide Controller Event Log Panel 

To display or hide the Controller Event Log, select Event View at the View menu. When the 
Controller Event Log panel displays, a checkmark appears next to the Event View option at the 
View menu. 

6.7.2 Log Window 

The [system name]: View Log window displays all of the messages generated by RAIDXpert2. 
All messages are logged, not just the ones enabled at Options > Notification.  

All messages received from the RAIDXpert2 driver are sent to a message log file. If desired, 
change the name of this file in the Notification window. 

By default, notification events in Windows-based systems are saved to:  

%Program Files%\RAIDXpert2\rc_service.log.  

Notification events in Linux-based systems are saved to /var/log/rc_service.log. 

At the View menu, select Log to view the RAIDXpert2 messages. 

6.7.3 Refresh the Display 

To refresh the display, select Refresh at the View menu. 
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6.8 Working with Options 
6.8.1 Change Password Settings 

A password can be changed at the Options menu. See Section 6.2.2, Change a Password at the 
Options Menu, on page 63. 

6.8.2 Set Event Notifications 

With the Notification option, the user can manage event log and email notifications of events. 

The Event View section of the Array Status window displays the priority listing. The event log 
priority levels, in ascending order, are indicated in Table 27. 

Table 27. Event Log Priority Levels 

Event Priority Description 

Low Displays messages for normal system operations. (This event is not 
displayed unless requested by the user.) 

Informational Displays information that might be useful to know. 

Warning The system user should to be informed about this event, but probably does 
not need to take action. 

Critical The system user must be informed about this event and should take action. 

Fatal The RAIDXpert2 driver is fatally damaged and the RAID subsystem has 
shut down. 

6.8.2.1 Set or Change Event Notifications 

1. At the Options menu, select Notification. The Notification Setup window opens.  
2. Specify the Outgoing Mail Server (SMTP) and To Email Address, to which e-mail 

messages are sent when an event occurs. 
3. If the SMTP server requires a login, check the Server Required Login box and enter a valid 

Username and Password for the server. 
4. Specify a user address as the sender of the e-mail notifications in From Email Address. (By 

default, the system on which RAIDXpert2 is installed is used.) 
5. Click Send Test Message to verify that the e-mail notification works. 
6. To disable messaging, uncheck the Enable Messaging check box in the Notification Events 

section. 
7. Choose the types of notification events to use (Email or Event Log) for each event priority 

(Low, Informational, Warning, Critical, Fatal) by selecting the appropriate options. 
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Note: Warning, Critical, and Fatal events will always display in the Event Log. 

6.8.3 Licensing 

To display Licensing information, including available licensing levels, select License at the 
Options menu. 

6.9 Add Space Using a RAIDABLE Array 
Note: RAIDABLE array is formerly known as RAID Ready array. 

1. Install a new disk. After a rescan, a pop-up window opens. 
Note: To create a redundant RAID1 array, the new disk must be the same size or greater than the 

RAIDABLE disk. 

2. In the Select a Disk section, select the new disk. 
3. In the Choose a Task section, select the desired option. 
Note: Selecting any option first initializes the disk before the selected task is started. 

a. Backup Array: This option creates a backup of the RAIDABLE array on the new disk. 
b. Transform Array: This option allows the user to either add space to the RAIDABLE 

array or create a redundant array. 
c. Initialize Disk for AMD-RAID: This option allows the disk to be used when creating 

arrays. 
d. Make disk a Global Spare: This option assigns the new disk as a global spare. 

4. In the Select a Source/Destination section: 
a. Select the Source RAIDABLE Array from the drop-down menu. 
b. Select the Destination Array Type from the drop-down menu. 

Note: The Destination Array Type option is only available when either the Backup Array task or 
Transform Array task is selected. Only valid array types for the number of disks inserted will 
be displayed. For example, if one new disk is inserted, only RAID0 or RAID1 will display in 
the drop-down menu. 

5. Click Confirm. 
If either the Backup Array task or Transform Array task is selected, a Task Progress dialog box 
opens. To hide the dialog box while the task is executing, click Close. 
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Chapter 7 Troubleshooting 

7.1 Troubleshooting 
The chapter discusses four major categories of troubleshooting: 

 Problems with system startup. 
 Warning messages that might appear at the Power-On Self-Test (POST) screen. 
 Problems with arrays. 
 Problems with disks. 

7.2 System Startup Problems 
 Table 28. The System Does Not Boot 
 Table 29. The BIOS Configuration Utility Does Not Display 
Table 28. The System Does Not Boot 

Possible Causes  Corrective Actions 

Controller mode is set 
incorrectly during system 
startup 

In the system’s BIOS screen, ensure SATA settings are in RAID 
mode. 

The system’s boot mode or 
boot sequence retry mode 
is set incorrectly 

In the system’s BIOS screen, ensure that the bootable array is the first 
array listed. 
If not, use the Swap Two Arrays option to reposition the arrays. 

A bootable array is in an 
Offline state 

Restart the system. 
Enter the system’s BIOS screen. 
Check the state of the bootable array. 
Check for missing or offline disks. 

Table 29. The BIOS Configuration Utility Does Not Display 

Possible Causes  Corrective Actions 

The controller mode is set 
incorrectly in the system 
BIOS 

In the system’s BIOS screen, ensure the SATA settings are correct. 
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Table 30. Username and Password 

Problem Corrective Actions 

A user forgets the 
username or password. 

Reset the username and password by deleting rc_login.txt. This 
restores the default user name and password (admin and admin). 

7.3 Warning Messages: POST Screen 
The POST screen is one of the first screens to appear during the system’s boot sequence. If the 
system’s arrays were in Normal or Ready state prior to a system boot, the boot sequence continues 
normally to the operating system. 

But, if an array is in Critical or Offline state, or if specific options at Controller Options were 
changed previously at the BIOS Configuration Utility, the warning messages described in Table 
31 appear during the boot sequence. 

Table 31. POST Screen Warning Messages 

Warning Message Additional Information Corrective Action 

WARNING: Found arrays 
that are Critical 
[or equivalent] 

This warning message appears when at 
least one array is in a Critical state and 
Toggle Pause if Critical is set to ON at 
the BIOS Configuration Utility. 
The Critical state of an array depends on 
the RAID level of the array and the 
number of disks that have failed. See 
Section 3.3, Array States, on page 25, for 
information on criticality. 
If an array is Critical (even a bootable 
array), the system can continue through 
the boot process to the operating system.  

See Section 7.5.1, 
Troubleshooting Disks, on 
page 93. 
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Table 31. POST Screen Warning Messages (Continued) 

Warning Message Additional Information Corrective Action 

WARNING: Found 
 arrays that are Offline  
[or equivalent] 
 
 

This warning message appears when at 
least one array is in an Offline state and 
Toggle Pause if Offline is set to ON at 
the BIOS Configuration Utility.  
If two or more disks in a redundant array 
have failed, or if a single or multiple 
disks in a non-redundant array have 
failed, data has been lost. 
In RAID10 array, if a single disk fails in 
each mirrored set, the redundant array 
goes to a Critical state but data is not 
lost. If two disks fail in one of the 
mirrored sets, the redundant array goes to 
an Offline state and data is lost. 

See Section 7.5.1, Troubleshooting 
Disks, on page 93. 
If, after performing a rescan, the state 
remains Offline, the bootable array has 
suffered an unrecoverable failure.  
Create a new bootable array. 
Reinstall the operating system and 
drivers. 

WARNING: Found  
arrays that are Critical 
and Offline 
[or equivalent] 

A bootable array that is in an Offline 
state prevents the operating system from 
booting. 

BIOS NOT INSTALLED - 
User Disabled INT13 
BIOS Load  
[or equivalent] 

This warning message appears when 
Toggle INT13 Boot Support option has 
been set to OFF at the BIOS 
Configuration Utility and another boot 
device is not selected. 
Bootable devices do not function with 
the controller when Toggle INT13 Boot 
Support is set to OFF. The default 
setting is ON, which allows bootable 
devices to function with the controller. 

Restart the system. 
Enter the system’s BIOS screen. 
Select Main Menu > Controller 
Options > Toggle INT13 Boot Support. 
Change Toggle INT13 Boot Support 
from OFF to ON. 
Navigate to Main Menu.  
Select Continue to Boot.  
The system boot process continues to the 
operating system. 

7.4 Array-Related Errors 
 Table 32. Cannot Create an Array, 90 
  
 Table 34. An Array is in an Offline State, on page 91 
 Table 33. An Array is in a Critical State, on page 91 
  
 Table 35. Cannot Assign a Dedicated Spare to an Array, on page 91 
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 Table 36. Cannot Create a Global Spare, on page 92 
  
 Table 37. Recreate a Deleted Array, on page 92 
Table 32. Cannot Create an Array 

Possible Causes Additional Information Corrective Actions 

The disk is not displayed.  The controller cannot communicate 
with the disks. 

See Section 7.5.1, Troubleshooting 
Disks, on page 93. 

Insufficient free space 
available on the selected 
disks 

 Select a different combination of 
disks. 

Incorrect number of disks 
selected for the desired 
RAID level 

See 3.2, RAID Levels, on page 24, 
for a description of RAID levels and 
the allowable number of disks used 
with each RAID level. 

Select the correct number of disks. 

The desired disk is 
unavailable. 

The disk is a dedicated spare for a 
different array. 
The disk is full. 
The disk’s available capacity is 
insufficient. 

Select a different disk. 

The disk has SMART 
errors. 

An array can be created with a disk 
that has SMART errors, but only if 
the array is created in the BIOS 
Configuration Utility.  
RAIDXpert2 cannot be used to 
create an array with a disk that has 
SMART errors. 

Use the BIOS Configuration Utility to 
create the array. 

The system already has a 
maximum of eight arrays  

 Delete unused arrays. 
CAUTION: Deleting an array 
permanently destroys all data that is 
on the array. This action cannot be 
undone and it is very unlikely the data 
can be recovered. 
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Table 33. An Array is in a Critical State 

Possible Causes Additional Information Corrective Actions 

One or more disks in the 
array have failed or been 
removed. 

Due to the failed disk or disks, the array is no 
longer maintaining redundant (mirrored or parity) 
data.  
The failure of an additional disk results in an 
Offline state and lost data.  

See Section 7.5.1, 
Troubleshooting Disks, 
on page 93. 

 

Table 34. An Array is in an Offline State 

Possible Causes Additional Information Corrective Actions 

The array has lost the 
maximum allowable disks 
per RAID level. 

One or more disks have failed. 
 If the array is non-redundant, the failure of a 

single disk causes the array to fail. 
 If the array is redundant, the failure of two or 

more disks causes the array to fail.  
The array cannot be restored (rebuilt). 

See Section 7.5.1, 
Troubleshooting Disks, 
on page 93. 

 

Table 35. Cannot Assign a Dedicated Spare to an Array 

Possible Causes Additional Information Corrective Actions 

The RAID level does not 
allow dedicated spares. 

Dedicated spares cannot be created for 
Volume or RAID0 arrays.  

 Create an array with a different 
RAID level and assign a 
dedicated spare. 

 Create a global spare. 

The designated disk does 
not have sufficient 
capacity to be a dedicated 
spare 

The capacity of the disk selected to be a 
dedicated spare must be equal to or 
larger than the capacity of the smallest 
disk in the array.  

Select a different disk. 
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Table 36. Cannot Create a Global Spare 

Possible Causes Additional Information Corrective Actions 

The disk is already part of 
an array 

A global spare cannot be selected if it 
is already part of an existing array. 

Select a different disk. 

There are no empty disks 
available or the disks have 
not been initialized 

A disk with a legacy state can be 
initialized, if desired, but it is no 
longer legacy (initialization adds 
RAIDXpert2 configuration 
information to the disk). 

Install additional disks. 
Initialize the disks.  
CAUTION: When a disk is initialized, 
all data on the disk is lost. 

The disk assigned as the 
global spare has failed or is 
missing. 

 See Section 7.5.1, Troubleshooting 
Disks, on page 93. 

 

Table 37. Recreate a Deleted Array 

Possible Causes Additional Information Corrective Actions 

An array(s) was 
accidentally deleted, or the 
wrong array was deleted 

This procedure might 
recreate a deleted array and 
with its data intact. 
However, this is not 
guaranteed to occur. 
If I/O was running to the 
deleted array(s) just prior 
to it being deleted, there 
might be some data loss in 
the recreated array(s). 
If multiple arrays were 
deleted, all of the deleted 
arrays must be recreated in 
order to recover the desired 
array. 

1. At the Array pop-up menu, select Create. 
2. Create a new array using the same settings 

as the deleted array. 
 The same disks. 
 The same RAID type (RAID level). 
 The same capacity. 
 The same cache options. 
3. Check Leave Existing Data Intact. 
4. Click Create. 
5. Ensure the settings are the same as the 

deleted array: 
 The same drive letter. 
 The same RAID type (RAID level). 
 The same disks. 
 The same capacity. 
 The same cache option  
6. Check the data files of the array for 

corrupted or missing files, incorrect file 
extensions, and so on. 
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7.5 Disk Related Errors 
 Table 38. Disk Errors 
 Section 7.5.1, Troubleshooting Disks, on page 93. 

Table 38. Disk Errors 

Possible Causes Additional Information Corrective Actions 

A disk has been removed from 
an array 

 See Section 7.5.1, 
Troubleshooting Disks, on page 
93. 

A disk is not visible in the BIOS 
Configuration Utility or is offline 

 

A disk is highlighted red at the 
BIOS Configuration Utility 

The disk has failed. 
Depending on the RAID level of 
the array, data might be lost. 

 

RAIDXpert2 cannot 
communicate with the spare 

The dedicated spare is not visible 
in the BIOS Configuration Utility 
or is offline. 

 

The disk cannot be initialized Only disks that are Ready can be 
initialized. 
CAUTION: When a disk is 
initialized, all data on the disk is 
lost. 

 Ensure the disk is not already 
a member of an array.  

 Ensure the disk is still 
assigned as a global or 
dedicated spare. 

 Ensure the disk is reporting a 
Ready state. 

7.5.1 Troubleshooting Disks 

Perform the following actions when there may be a problem with a disk. 

 Ensure there is no damage to the system’s backplane. 
 Ensure all cables are installed correctly. 
 Ensure the disk is seated correctly in the backplane or bay and the latch is secured.  
 Reinsert the disk. 
 Replace the disk. 
 After reconnecting, reseating, reinserting, or replacing a disk: 

 Perform a rescan. 
 Initialize the disk. 

CAUTION: When a disk is initialized, all data on the disk is lost. 
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If problems with a disk have caused an array to go Critical, it may be necessary to also assign a 
dedicated or global spare for the array. 

If problems with a disk have caused an array to go Offline, data may have been lost. Recover lost 
data from a backup storage source. 
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Chapter 8 Software License: EULA 

8.1 Software License: End-User License Agreement 
(EULA) 

BY INSTALLING, DOWNLOADING AND/OR USING THE SOFTWARE THAT 
ACCOMPANIES THIS END USER LICENSE AGREEMENT (“AGREEMENT”) AND ANY 
ASSOCIATED DOCUMENTATION OR UPDATES THERETO ("SOFTWARE"), YOU 
AGREE THAT, WHETHER AS AN INDIVIDUAL OR AUTHORIZED REPRESENTATIVE 
OF AN ENTITY, YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE 
TO BE BOUND BY IT. IF YOU DO NOT AGREE TO IT, YOU ARE NOT AUTHORIZED TO 
INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE AND ARE ASKED TO 
PLEASE RETURN THE SOFTWARE TO THE PARTY FROM WHOM YOU RECEIVED IT. 
THE RIGHT TO USE THE SOFTWARE IS GRANTED ONLY UPON THE CONDITION 
THAT YOU AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. 

FURTHER, YOU UNDERSTAND THAT THIS SOFTWARE MAY ONLY BE OBTAINED 
FROM Advanced Micro Devices, Inc. (“AMD”) OR AN AUTHORIZED DISTRIBUTOR OF 
AMD. IF YOU OBTAINED THIS SOFTWARE FROM ANY OTHER SOURCE, THAT 
SOURCE PROVIDED IT TO YOU ILLEGALLY, AND YOU HAVE NO RIGHT TO 
INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE; SUCH USE IS A 
VIOLATION OF INTELLECTUAL PROPERTY RIGHTS. 

8.1.1 Limited License to Authorized Distributors 

If you are an OEM, distributor, reseller, integrator or other entity in the business of providing 
technology products and/or services, and if you have been expressly authorized to distribute copies 
of the Software to End User(s), you are an "Authorized Distributor." Subject to the terms and 
conditions of this Agreement, you are granted a limited, non-exclusive, non-transferable, non-sub 
licensable license to distribute and/or install the Software in its unaltered, object code form solely 
(i) to, and on behalf of, a purchasing End User for the End User’s internal business purposes; and 
(ii) only for use with one (1) AMD product, purchased through authorized AMD sales channels. 
Except as specifically stated in this Section 1, Authorized Distributors are expressly prohibited 
from: copying and/or distributing the Software in whole or in part; using the Software to provide 
consulting or other services to third parties; and distributing the Software in any form or format. 
Authorized Distributors are subject to all other terms and conditions of this Agreement. 
Authorized Distributors must ensure that its End Users see and agree to this Agreement. 

8.1.2 Limited License to End Users 

If you have licensed the Software for your own personal use or your company's internal use, you 
are an "End User." You are hereby granted, subject to the terms and conditions of this Agreement, 
a limited, non-exclusive, non-transferable, non-sublicensable license to use this Software in its 
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unaltered, object code form solely (i) for internal business purposes; and (ii) only with respect to 
one (1) AMD product that was purchased through authorized AMD sales channels. Further, you 
must obtain this Software only from authorized AMD sales channels. Obtaining it from any other 
source is a violation of the intellectual property rights of AMD and its licensors. 

8.1.3 Restrictions 

Except as expressly authorized in Sections 1 and 2 above, Authorized Distributors and End Users 
(collectively "You”) shall not (nor cause or permit any other person to): (i) reverse engineer, 
translate, disassemble, derive source code from, decompile, rent, lease, manufacture, adapt, create 
derivative works from, or otherwise modify or distribute the Software or any part thereof; (ii) 
copy, in whole or in part, the Software with the exception that only End Users may make one copy 
of the Software for their backup or archival purposes; (iii) publicly display the Software or use the 
Software to provide consulting or other services to third parties; or (iv) delete any copyright, 
trademark, patent or other notices of proprietary rights as they appear anywhere in or on the 
Software. 

8.1.4 Proprietary Rights 

The Software is primarily the intellectual property of Dot Hill Systems Corp. (“Dot Hill”) and its 
licensors (“Licensors”). In no event shall You obtain title to the Software or any component 
thereof. As between Dot Hill and You, Dot Hill has all rights, title, interest, ownership and 
proprietary rights in and to the Software. Dot Hill's rights include, but are not limited to, all copies 
of the Software and any patent rights, copyrights, trademark rights, trade secret rights, and any 
other intellectual property right recognized in any country or jurisdiction in the world. The 
Software is protected both by United States law and international treaty provisions.   All rights not 
expressly granted in this Agreement are reserved by Dot Hill and Licensors, respectively. 

8.1.5 Term and Termination 

This Agreement shall continue in effect until terminated. Dot Hill or AMD may terminate this 
Agreement immediately if You fail to comply with any provision of this Agreement. Upon 
termination, You shall discontinue use of the Software, and either destroy, erase, or return all 
copies of the Software in Your possession or control. 

8.1.6 No Warranty 

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED. DOT HILL AND AMD DISCLAIM, ON THEIR OWN BEHALF 
AND ON BEHALF OF LICENSORS, ANY EXPRESS OR IMPLIED WARRANTIES 
INCLUDING ANY IMPLIED WARRANTIES OF NONINFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE SOFTWARE 
OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR 
ERROR-FREE OR WILL OPERATE IN COMBINATION WITH OTHER SOFTWARE OR 
HARDWARE. Dot Hill and its Licensors will not provide support for the Software and, to the 
extent you believe that are entitled to support, you are advised to contact the party from whom you 
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received the Software. Notwithstanding the foregoing, Updates to the Software (which may or 
may not be distributed) shall be governed by this Agreement, and such Updates will be considered 
Software for purposes of this Agreement. 

The Software is not absolutely fault-tolerant and is not designed, manufactured or intended for use 
or resale as on-line control equipment in hazardous environments requiring fail-safe performance 
in which the failure of the Software could lead directly to death, personal injury or severe physical 
or environmental damage, such as the operation of nuclear facilities, aircraft navigation, air traffic 
control, direct life support machines, or weapons systems (“High Risk Activities”). Express or 
implied warranties for High Risk Activities are specifically disclaimed. 

8.1.7 Limitation of Liability 

IN NO EVENT SHALL DOT HILL, AMD OR LICENSORS BE LIABLE TO ANY PARTY 
FOR ANY LOST REVENUE, LOST PROFIT OR DATA, OR FOR SPECIAL, INDIRECT, 
CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED, AND 
REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR 
INABILITY TO USE THE SOFTWARE EVEN IF THEY HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL DOT HILL'S, AMD’s or 
LICENSORS’ LIABILITY, TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING 
NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNT OF ANY FEE PAID BY YOU 
FOR THE SOFTWARE. THE FOREGOING LIMITATIONS SHALL APPLY EVEN IF THE 
REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some jurisdictions do not allow for the 
exclusion of implied warranties as described in Section 6, or the limitation of liabilities as 
described in this Section 7, so the above exclusions or limitations may not apply to You. In that 
event, to the extent permissible, any exclusion of warranties or limitation of liability will be 
limited in duration or type to the greatest extent allowed by law. 

8.1.8 Export Controls 

You agree to comply fully with all relevant export laws, regulations, treaties, and orders ("Export 
Laws") to assure that neither the Software nor any components thereof are (i) exported, directly or 
indirectly, in violation of Export Laws; or (ii) are intended to be used or are used for any purposes 
prohibited by the Export Laws. 

8.1.9 General 

This Agreement and any disputes arising from or relating to it shall be governed by and construed 
in accordance with the laws of the State of Colorado without reference to conflict of laws 
principles and excluding the U.N. Convention on Contracts for the International Sale of Goods. 
Any legal action or proceeding shall be instituted in a state or federal court in Denver, Colorado, 
U.S.A. and You agree to be subject to the jurisdiction of these courts. Taxes and charges imposed 
by any government with respect to the Software shall be paid by the End User. The waiver by 
either party of a breach of this Agreement or a failure to exercise any right hereunder shall not 
operate or be construed as a waiver of any subsequent breach or as a waiver of any other right. If 
any provision of this Agreement is held to be unenforceable or overbroad for any reason, it will be 
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modified rather than voided, if possible, in order to achieve the intent of the parties to the extent 
necessary to make the provision enforceable under applicable law, and enforced as amended. In 
any event, all other provisions of this Agreement will be deemed valid and enforceable to the full 
extent. This Agreement constitutes the complete agreement between the parties and supersedes all 
prior or contemporaneous agreements or representations, written or oral, concerning the subject 
matter of this Agreement including any purchase order or ordering document. This Agreement 
may not be modified or amended except in writing and signed by both parties. 
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Chapter 9 rcadm Command Line Interface 
Tool 

9.1 What is rcadm? 
The rcadm program is a command line interface (CLI) tool for managing RAIDXpert2 in the 
Windows, Linux, or EFI operating system.  See Appendix A, on page 107, for rcadm.efi 
Information. 

The rcadm program initiates RAIDXpert2 operations, such as:  

 Manage RAIDXpert2, arrays and disks (see Section 9.2, Manage Arrays and Disks: rcadm -
-manage, on page 100). 

 Create new arrays (see Section 9.4, Create New Arrays: rcadm --create, on page 104). 
 Delete arrays (see Section 9.5, Delete Arrays: rcadm --delete, on page 105). 

 Transform arrays (see Section 9.6, Transform Arrays: rcadm --transform (supported by 
RAIDXpert2 Plus), on page 106). 

 Follow or monitor arrays and disks (see Section 9.7, Follow or Monitor Arrays and Disks: 
rcadm --follow, on page 106). 

 Information on drive and array states. 
The rcadm program has five primary modes, with most primary modes having additional optional 
arguments. The five modes of operation are indicated in Table 39. 

Table 39. Modes for the rcadm Program 

Mode Usage 

Manage Uses the rcadm --manage command to manage and query RAIDXpert2, 
arrays, and disks. 

Create Uses the rcadm --create command to create a new array. 

Delete Uses the rcadm --delete command to delete arrays. 

Transform Uses the rcadm --transform command to transform an array.  
(supported by RAIDXpert2 Plus) 

Follow Uses the rcadm --follow command to follow or monitor arrays and disks. 

Follow these instructions to issue the command on the operating system. Also, see Section 9.3, 
View Help from the Command Line, on page 104. 



  

AMD-RAIDXpert2 User Guide 53987 Rev. 3.01 June 2016  
 

100 rcadm Command Line Interface Tool  Chapter 9 
 

9.1.1 To Use rcadm with a Linux® Operating System 

By default, rcadm is installed in /usr/bin.  

9.1.2 To Use rcadm with a Windows® Operating System 

 Change directories to %Program Files%\RAIDXpert2. 
 Run the rcadm.exe command from there. 

or 
 Add %Program Files%\RAIDXpert2 to the system or user path environment variables. 

9.2 Manage Arrays and Disks: rcadm --manage 
The rcadm --manage or rcadm -M command allows the user to view information about 
RAIDXpert2 and manage the arrays and disks. 

For example, the user can: 

 Set cache attributes for arrays. 
 Set priority levels for tasks on an array. 
 Hide and unhide arrays. 
 List arrays. 
 Initialize disks. 
 Query information about disks. 
 Add and remove spares from an array. 
 Set cache attributes for disks. 

9.2.1 Understand Query Output 

When the rcadm --manage --query-all command is used, information about the disks 
and arrays for the system is displayed.  

To see information about a specific controller, disk, or array use the rcadm --manage --
query command, in conjunction with the appropriate options.  
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9.2.2 rcadm Controller List Elements 

Table 40. rcadm Controller List Elements 

Element Description 

Number Controller number assigned by RAIDXpert2 

Type Model number of the controller 

Serial Number Serial number of the controller 

Port Count The number of ports supported by RAIDXpert2 

PCIe® Vendor ID The PCIe vendor identification number 

PCIe Device ID The PCIe device identification number 

PCIe SubVendor ID The PCIe sub-vendor identification number 

PCIe SubDevice ID The PCIe sub-device identification number 

SAS Address (WWID) The SAS Address (world-wide identification number) 

BIOS Version The version of the AMD-RAID Configuration BIOS 
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9.2.3 rcadm Disk List Elements 

Table 41. rcadm Disk List Elements 

Element Description 

Disk Disk number assigned by RAIDXpert2, corresponding to the SATA 
channel ID. 

State State of the disk (Online, Failed, Unknown) 

Disk Type Disk type (Disk, Legacy, Neaw, ATAPI) 

Port Type Port type (SATA, SATA II, eSATA, SSD) 

Port Speed The negotiated speed of the port 

Size Total size of the disk: 
 1 MB = 1,000,000 bytes 
 1 GB = 1,000,000,000 bytes 
Note: Because the ATA storage industry has standardized the meanings of 

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 
reports the same units. 

Free Space Total amount of space unused on the disk 

Largest Free Space Largest contiguous unused space on the disk 

GS Indicates if the disk is assigned as a global spare 

Ca Current disk cache setting (NC = No Cache, R = Read Cache, W = Write 
Back Cache, RW = Read + Write Back Cache). 

Ctrl Chan Disk controller and channel number. 

Vendor  Disk vendor 

Model Number Disk model number 

Firmware Version Disk firmware version 

Serial Number Disk serial number 
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9.2.4 rcadm Array List Elements 

Table 42. rcadm Array List Elements 

Element Description 

A Array number assigned by RAIDXpert2 

Type RAID type. 

O.S. Name Name assigned by the operating system to the array. The name shows as 
“Hidden” if the array is hidden from the operating system. The name 
shows “??” if the array is Offline. 

Sys or System Device Indicates whether or not the array is being used as a system disk under 
Windows 

State State of the array (Normal, Critical, Offline) 

Size or Capacity Total size of the disk: 
 1 MB = 1,000,000 bytes 
 1 GB = 1,000,000,000 bytes 
Note: Because the ATA storage industry has standardized the meanings of 

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 
reports the same units. 

Hide  Whether the array is hidden from the operating system 

Id Globally unique identifier for the array assigned by RAIDXpert2 

Task Task type (Transform, Check, Check_Bitmap, Not_Active, Create, 
Restore) 
Note: See Section 3.7, Array Tasks: Starting and Stopping Tasks, on page 

28 for detailed definitions. 

Task State The state of the task (Started, Paused, Completed) 

% The progress of a current array task, such as a Create or Transform, shown 
as percent complete 

CA  Current array cache setting (NC=No Cache, R=Read Cache, W=Write Back 
Cache, RW=Read + Write Back Cache). 
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Table 42. rcadm Array List Elements (Continued) 

Element Description 

Scan Background scan enabled (Yes/No) 

Name User-supplied name for the array 

Dedicated Spare Indicates the number of dedicated spares assigned to the array  
(--verbose mode only) 

Disk Listing of disks that are part of the array 

Used Capacity used of a specific disk 

Offset Location on the disk where the array begins 

9.3 View Help from the Command Line 
9.3.1 To view a List of the Major Modes of Operation 

Type: rcadm --help or rcadm -? 

9.3.1.1 To View Help for a Specific Mode and its Options 

Type: rcadm <mode> --help or rcadm < mode> -? 

For example, typing rcadm --manage --help displays help and examples regarding that 
specific mode and its options. 

9.3.1.2 To view the rcadm Man Page on a Linux® System 

Type: man rcadm 

9.4 Create New Arrays: rcadm --create 
The rcadm --create or rcadm -C command allows new arrays to be created. As many as 
eight arrays can be partitioned and created across all disks.  

Portions of disks can be used to create arrays, while other arrays are using different portions of the 
same disks. A maximum of eight arrays can be created. 
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9.4.1 Before You Begin... 

Creation of arrays, even redundant arrays, allows users immediate access to the arrays. If the 
system reboots, the creation process continues where it left off.  

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to 
function properly, but are not supported. 

Note: The array size of the new array is limited to 2.199 TB with some operating systems. Refer to 
the operating system documentation for details on maximum array sizes. 

Note: The ability to create RAID10 or RAIDABLE arrays may not be available on your system. 

9.4.2 Example 

To create a 1 GB RAID5 array using disk members 1, 2, and 3, type: rcadm -C -r5 -d 1 2 
3 -s 1000 

To see more examples, type: rcadm -C -? 

9.5 Delete Arrays: rcadm --delete 
The rcadm --delete or rcadm -D command allows the user to delete one or more arrays. 

CAUTION: Deleting an array permanently destroys all data that is on the array. This action 
cannot be undone and it is very unlikely the data can be recovered. 

9.5.1 Before You Begin... 

 If the operating system is using an array it cannot be deleted. 
 If an array is accidentally deleted, and the user wants to try and recover the data, create an 

array using the same disks, same size, and same cache, and use the --leave-existing-data 
option. This option writes new configuration information to the array while trying to use the 
exact same disk space as before.  

9.5.2 Example 

To delete array 1, type: rcadm -D -a 1 

To see more examples, type rcadm -D -? 
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9.6 Transform Arrays: rcadm --transform 
(supported by RAIDXpert2 Plus) 

The rcadm --transform or rcadm -T command allows the user to transform (migrate) an 
array from one RAID level to almost any other RAID level, and to expand the array dynamically, 
even under I/O load.  

9.6.1 Before You Begin... 

 An array cannot be transformed to a smaller-sized array. New arrays must be either the same 
capacity or larger. 

 When using the task control option, a Transform can only be paused or resumed but not 
removed. 

 If a spare has been assigned to the destination array, a fail-over task starts as soon as the 
Transform completes, provided the spare is available after the Transform. 

 If there are multiple arrays on a single controller, it might not be possible to transform some of 
the arrays to a larger size. If the size of an array might be expanded in the future, it is best to 
configure the available space as a single array. 

 The array size of the transformed array is limited to 2.199 TB on some operating systems. 

9.7 Follow or Monitor Arrays and Disks: rcadm --
follow 

The rcadm --follow or rcadm -F command allows the user to follow or monitor arrays 
and disks. It polls the RAID subsystem for any changes in status and sends an e-mail notification 
and/or executes a specified program. The output of this command is logged to the System Event 
Log on Windows.  

9.7.1 Before You Begin... 

It is recommended that the user not run more than one instance of rcadm --follow at the same time. 
If the user runs more than one instance of the command, each instance captures some of the events 
but no single instance captures all events. 
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Appendix A rcadm.efi Information 
A.1  rcadm -? 
-?, --help 

Displays all primary rcadm commands, or if used after an option, displays help for that 
specific option. 

-log, --log-file 

Print output to a log file as well as standard output. Requires a log file name argument. 
Overwrites existing file. Only one occurrence of this option on the command line is allowed. 

Example: rcadm -M -qa -v -log status.txt 

-C, --create 

Command for creating arrays. Array types include linear (JBOD), volume (JBOD), RAID0, 
RAID1, RAID1n, RAID10, RAID10n, RAID5, RAID50, RAID6, RAID60, and RAIDABLE. 
Some of the major functions include assigning spare disks; setting array size; setting the 
number of disks in each sub member of a RAID10n or RAID50 array; and setting cache 
attributes. 

-D, --delete 

Command for deleting arrays. This mode does not have any optional arguments. 

-M, --manage 

Commands for managing and querying controllers, arrays, and disks. Some of the major 
functions include querying for information, adding and removing dedicated and global spare 
disks, setting cache attributes for arrays and disks, performing consistency checks on 
redundant array types, initializing disks, prioritizing tasks for arrays, scanning arrays and disks 
for changes in status, and hiding or unhiding arrays. 



  

AMD-RAIDXpert2 User Guide 53987 Rev. 3.01 June 2016  
 

108 rcadm Command Line Interface Tool  Chapter 9 
 

A.2 rcadm -M 
MANAGE 
-a, --array 

Used with certain options to specify arrays. 

-as, --add-spare 

Adds a dedicated spare disk to an array. No space is reserved on the disk selected. 

-rs, --remove-spare 

Removes a dedicated spare disk from an array. 

-ras, --remove-all-spares 

Removes any spares from an array. 

-ags, --add-global-spare 

Adds a disk as a global spare. No space is reserved on the disk selected. 

-rgs, --remove-global-spare 

Removes a global spare disk. 

-ca, --cache-array 

Sets the cache attributes for an array. Cache attributes include read cache (r), read and write-
back cache (rw), write-back cache (w), and no cache (nc). 

-cd, --cache-disk 

Sets the cache attributes for a disk. Cache attributes include read cache (r), read and writeback 
cache (rw), write-back cache (w), and no cache (nc). 

-d, --disk 

A required qualifier used with certain options to specify disks. 

-h, --hide 

Hides an array from the operating system. 

-uh, --unhide 

Unhides an array, making it visible to the operating system. 

-id, --initialize-disk 

Initializes a disk. If the disk is new and has not been used, you must initialize it before you can 
create arrays. 
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-n, --name 

Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 
17 of those characters display in the BIOS. 

-p, --priority 

Sets an array's task priority from 1-10, with 10 being the highest priority. 

-q, --query 

Lists information about specific controllers, arrays, and disks. 

-qa, --query-all 

Lists information about controllers, arrays, and disks. 

-v, --verbose 

Modifier of the --query and --query-all option. Specifies more detail for arrays and disks. 

-rsc, --rescan 

Rescans the serial ATA (SATA) channels for new or removed disks. 

-sa, --scan-array <on|off> 

Specifies if background array scan scanning is on or off. 

-sp, --smart-poll 

Turns SMART polling on or off for the specified drive(s). 

-t, --task 

Used to pause, resume, and remove tasks. 

-ul, --unlink 

Unlinks two arrays linked through a create copy operation. 

SYNTAX and EXAMPLES 
ADD SPARE 

--add-spare --array <list> --disk <list>  

-as -a <list> -d <list> 

Examples: rcadm --manage --add-spare --array * --disk 1 
rcadm -M -as -a 1 2 -d 5 6 
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REMOVE SPARE 
--remove-spare --array <list> --disk <list> 

-rs -a <list> -d <list> 

Examples: rcadm --manage --remove-spare --array 5 --disk * 
rcadm -M -rs -a * -d 5 

REMOVE ALL SPARES 
--remove-all-spares --array <list> 

-ras -a <list> 

Examples: rcadm --manage --remove-all-spares --array 5 
rcadm -M -ras -a * 

ADD GLOBAL SPARE 
--add-global-spare --disk <list> 

-ags -d <list> 

Examples: rcadm --manage --add-global-spare --disk 1 2 3 
rcadm -M -ags -d * 

REMOVE GLOBAL SPARE 
--remove-global-spare --disk <list> 

-rgs -d <list> 

Examples: rcadm --manage --remove-global-spare --disk * 
rcadm -M -rgs -d 5 

CACHE SETTINGS FOR ARRAYS 
--cache-array <cache_attribute> --array <list> 

-ca <cache_attribute> -a <list> 

Cache attributes: <r> for read cache 

<rw> for read and write-back cache 

<w> for write-back cache 

<nc> for no cache 

Examples: rcadm --manage --cache-array rw --array * 
rcadm -M -ca nc -a 1 
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DISK SETTINGS (Advanced) 
Disk cache: 

--cache-disk <cache_attribute> --disk <list> 

-cd <cache_attribute> -d <list> 

Cache attributes: <r> for read cache 

<rw> for read and write-back cache 

<w> for write-back cache 

<nc> for no cache 

Examples: rcadm --manage --cache-disk r --disk 1 2 3 
rcadm -M -cd w -d * 

HIDE ARRAY 
--hide --array <list> 

-h -a <list> 

Examples: rcadm --manage --hide --array 5 6 
rcadm -M -h -a 4 

UNHIDE ARRAY 
--unhide --array <list> 

-uh -a <list> 

Examples: rcadm --manage --unhide --array * 
rcadm -M -uh -a 5 

INITIALIZE DISK 
--initialize-disk --disk <list> 

-id -d <list> 

Examples: rcadm --manage --initialize-disk --disk * 
rcadm -M -id -d 1 2 3 

NAME ARRAY 
--name "name" --array <list> 

-n "name" -a <list> 

Examples: rcadm --manage --name "System Disk" --array 5 
rcadm -M -n "Backup Disk" -a 4 
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QUERY 
--query [--array <list>] [--disk <list>] 

[--verbose] 

-q [-a <list>] [-ct <list>] [-d <list>] [-v] 

Examples: rcadm --manage --query --array 1 --disk --verbose 
rcadm -M -q -a 1 2 3 -d -v 

QUERY ALL 
--query-all 

-qa 

Example: rcadm --manage --query-all 
RESCAN DISKS 

--rescan 

-rsc 

Example: rcadm --manage --rescan 
SCAN ARRAY 

--scan-array <on|off> --array <array_number> 

-sa <on|off> -a <array_number> 

Example: rcadm -M --array 1 --scan-array on 
rcadm -M -a 1 -sa off 

SMART POLL 
--smart-poll <on|off> --disk <list> 

-sp <on|off> -d <list> 

Example: rcadm --manage --smart-poll on --disk 
rcadm -M -sp off -d 1 2 3 

TASK CONTROL 
--task <task_operation> --array <array_number> 

-t <task_operation> -a <array_number> 

Task Operation 

<pause> to temporarily pause a task 

<resume> to continue running a task 

<remove> to permanently remove a task 

Examples: rcadm --manage --task pause --array 5 
rcadm -M -t remove -a 4 
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TASK PRIORITY 
--priority <1..10> --array <list> 

-p <1..10> -a <list> 

Examples: rcadm --manage --priority 5 --array 6 
rcadm -M -p 1 -a 

UNLINK ARRAY 

--unlink --array <array_number> 

-ul -a <array_number> 

Examples: rcadm --manage --unlink --array 2 
rcadm -M -ul -a 5 

A.3 rcadm -C 
CREATE 
Long form: 

rcadm --create <raid_type> --disk <list> [--size <size_mb>] 

[--sub-member <num>] [--spare-disk <list>] 

[--no-sync] [--d-spare] [--cache <r,rw,w,nc>] 

[--max-size] [--name "name"] [--priority <1..10>] 

[--zero][--scan-array] 

Short form: 

rcadm -C <raid_type> -d <list> [-s <size_mb>] [-sub <num>] 

[-sp <list>] [-ns] [-ds] [-ca <r, rw, w, nc>] [-ms] 

[-n "name"] [-p <1..10>] [-z] [-sa] } 

RAID Types: 

--volume, -v Single disk or concatenation of disks (JBOD) 
--raidable, -ra Single disk, RAIDABLE 
--raid0, -r0 Stripe of two or more disks 
--raid1, -r1 Mirror of two disks 
--raid10, -r10 Stripe set of mirror sets 
--raid5, -r5 Stripe set with parity, three to sixteen disks 
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OPTIONS 
-sp, --spare-disk 

Specifies the dedicated spare disk or disks to assign, with a maximum of four. No space is 
reserved on the selected disks. 

-s, --size 

Specifies the size of the array in MBs. If you do not use this option, the largest possible size is 
used by default. 

-ns, --no-sync 

Disables background synchronization of redundant types when creating the array. 

-ca, --cache 

Specifies a cache setting for the array(s): read cache <r>, read and write-back cache <rw>, write-
back cache <w>, or no cache <nc>. The default is read and write-back cache <rw>. 

-ms, --max-size 

Prints the maximum possible size for an array without actually creating an array. 

-n, --name 

Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 17 of 
those characters display in the BIOS. 

-p, --priority 

Sets the background initialization task priority from 1 to 10, with 10 being the highest priority. For 
redundant array types only. 

-led, --leave-existing-data 

Leaves the existing data on the disks untouched after the array is created. This option can be used 
to try to recover user data when an array has been accidentally deleted or the configuration 
information is lost but the data is still intact. Unless you immediately recreate the array after 
deleting it and no other tasks have been performed, the likelihood of recovering data with this 
method is very low. 

-d, --disk 

A required qualifier used with the --create option to specify the disk or disks to be included in the 
array. 

-sa, --scan-array 

Specifies that a background array scan should be continuously run whenever the array is idle 
(Default is off). 

-z, --zero 

Zero the array in the foreground. This method is faster than doing a background consistency 
verifies if the array is a redundant type. For non-redundant types, the zero option can be used to 
verify all blocks in the array can be accessed. 
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EXAMPLES 
Example: Create a RAID5 set of the maximum possible size using all disks. 

rcadm -C --raid5 --disk * 

Example: Create a RAID1 set of the maximum possible size, with a spare disk and without a 
background initialization task. 

rcadm -C --raid1 --spare-disk 3 --disk 1 2 --no-sync 

Example: Print the maximum size a RAID5 array could be using all disks without actually 
creating the array. 

rcadm -C --raid5 --disk * --max-size 

A.4 rcadm -D 
DELETE 
Long form: 

--delete --array <list> [--no-ask] 

Short form: 

-D -a <list> [-na] [-cg <group number>] 

OPTIONS 
-na, --no-ask 

If the no ask option is specified the array is deleted without confirmation. 

EXAMPLES 
Example: Delete arrays 1 and 2. 

rcadm -D --array 1 2 

Example: Delete all arrays. 
rcadm -D --array 
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